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Conventions

Boldface Words in boldface type represent programs and commands.

Capitalization Capitalized first letters represent company or product names.

Computer font Words in computer font represent file or path names, 
command syntax statements, prompts or messages that appear 
on your screen, or text you should type on your workstation or 
terminal.

Italics Words in italics represent variables in syntax statements 
or words that are emphasized in the text.

{ } Represents required elements in a syntax statement. 
When several elements are separated by the | symbol, 
you must select one of the elements.

[ ] Represents optional elements in a syntax statement.
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Chapter 1: Concepts 
Introduction
Introduction
This chapter introduces the basic concepts of the HP OpenView Smart Plug-in 
for Microsoft® Exchange Server (Exchange SPI), version A.08.20, which works 
together with HP OpenView Operations for UNIX versions 7.x and 8.x, to 
monitor Microsoft Exchange 5.5, 2000 and 2003. 

The chapter includes the following sections:

What the Exchange SPI does
OVO UNIX 8.0 DCE and HTTPS agents
How the Exchange SPI works
Exchange organization
Exchange SPI components:

Exchange SPI Template groups and Templates
Exchange SPI Application groups and Applications
Exchange SPI Message groups and Messages
Exchange SPI Reports and Graphs
1 - 2
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What the Exchange SPI does
The Exchange SPI adds Exchange 5.5, 2000 and 2003 server-monitoring 
capabilities to HP OpenView Operations for UNIX, allowing you to oversee 
your distributed Exchange environment from a central, easy-to-use console. In 
so doing, you can:

Increase Exchange availability and performance
Lower support costs associated with the Exchange service
Improve capacity management and planning for Exchange

With the Exchange SPI integrated into the OVO console, you can apply the HP 
OpenView performance and problem management processes that you use for 
networks and systems to monitor MS Exchange.

After setup, the Exchange SPI will monitor critical Exchange 
application/database resources including:

Processes (for monitoring the amount of CPU time being used by core 
Exchange processes)

Inactive Processes (for monitoring core MS Exchange processes for activity 
and status)

Exchange Services (for monitoring Exchange Server processes for activity 
levels)

Message Transfer Agent (MTA) and Simple Mail Transfer Protocol (SMTP) 
message process data

MTA Work Queue and SMTP Queues

IS Public and Private/Mailbox Average Delivery Time

Cluster environments.

Information comes to you in the OpenView Operations console through service 
maps, messages, alerts, reports and graphs. 
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OVO UNIX 8 DCE AND HTTPS AGENTS 

The Exchange SPI supports the new HTTPS agent, which comes with 
out-of-the-box HTTP authentication and SSL encryption, with server and client 
certificates, guaranteeing secure communication with the HP OpenView 
Operations central management servers. The new agent is available for all 
popular operating system platforms, including HP-UX, Microsoft Windows, 
Linux, and Solaris. 

When you upgrade from OVO 7.x to OVO 8.x and install the new agent, no 
manual configuration is necessary. 

UPGRADING AN EXCHANGE NODE FROM DCE TO HTTPS:

If an Exchange server node is already managed under a DCE agent, make sure 
the OVPA log files are cleared before remanaging it under HTTPS.  

To clean the log files, run the following command:

C:\usr\OV\bin\OpC\monitor\ddfutil.exe 
"C:\usr\OV\exspi\dsi\log\exspi_log" -rm all
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How the Exchange SPI works
Like other Smart Plug-ins, the Exchange SPI collects data that is targeted and 
gathered according to rules and schedule specifications contained within the 
Exchange SPI templates. 

HOW DATA COLLECTION OCCURS 

When the collection’s scheduled time occurs, the Exchange SPI 
collector/analyzer program is executed and if required, forwards metric values to 
OVO and the HP data collecting agent. At the same time, OVO checks against 
predefined threshold settings and triggers alarms when violations occur. 

WHERE DATA IS STORED 

The collected data is written to a log file residing on the managed node, at 
pre-defined intervals. 

HOW DATA IS DISPLAYED 

Messages appear in the OVO Message Browser with message details containing 
instruction text to help diagnose and remedy problems. If PerfView is present, 
metric values are available as graphs and if Reporter is installed, reports are 
available.
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Exchange organization
The Exchange organization in an enterprise can be extremely complex, the diagram 
below might help in keeping an overview:
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Exchange SPI components
The following components appear in the OpenView for UNIX GUI when 
Exchange SPI is installed:

1. Exchange SPI Template groups and Templates
2. Exchange SPI Application groups and Applications
3. Exchange SPI Message groups and Messages
4. Exchange SPI Reports and Graphs
1 - 7
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1. EXCHANGE SPI TEMPLATE GROUPS AND TEMPLATES

Templates

NOTE: In OVOU 8 and later, templates are referred to as policies.

Templates measure collected data against predefined rules, generating alarms 
and messages to assist in problem analysis and resolution. Corrective actions are 
suggested in help text available in the message details.
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Templates can be distributed as groups or individually. For a complete listing of 
templates, see Appendix B, beginning on page 183.

Template groups

The EXSPI Quick Start template group contains templates that are easy to 
install and distribute and require no special customization. Many templates in the 
EXSPI Add-Ons and EXSPI Advanced template groups require a more 
advanced configuration procedure. Before getting started, review template 
requirements in Exspi Template Group Requirements chapter 4  page 89.

Template types 

Within the Exchange group are:

 Schedule templates that determine when and what metrics are 
collected

 Monitor templates that implement the actual metric condition 
(threshold, object, message text, instructions, etc.) 

Message templates that intercept the Exchange SPI messages

Logfile encapsulator templates that monitor for Exchange server 
related messages in the Windows event log, and send them to the OVO 
Message browser. 

For information on customizing template settings, see Basic Customization 
chapter 6  page 110.

NOTE: This version of the Exchange SPI monitors MS Exchange 2003, 2000 and 5.5. 
Template and Template group names contain the version number in the prefix: 
65 refers to Exchange 2003 only, 60 refers to Exchange 2000 and 2003, and 55 
to Exchange 5.5 only. For example, where an Exchange 5.5 template group has 
the name EXSPI-55 Event Log Errors, the equivalent Exchange 2000 and 
2003  template group  is  EXSPI-60 Event Log Errors.                                                                                                                   
In this guide, templates/template groups relevant to all Exchange versions are 
referred as EXSPI-55/60 <template name>.
1 - 9



Chapter 1: Concepts 
Exchange SPI components
2. EXCHANGE SPI APPLICATION GROUPS AND 
APPLICATIONS

The Exchange SPI applications are available in the OVO Application Bank 
under the application group, EXSPI Admin, which contains the Exchange 2000 
and 2003, and Exchange 5.5 application groups.

EXSPI Admin application group in the Application Bank window.

In the Application Group for each version of Exchange are the following 
applications :

EXSPI Add DataSource: Exchange SPI application to configure data 
sources and start the logging of data.
1 - 10
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EXSPI Graphs: Contains graphs that can be generated from selected 
metric monitors. Note: Only PerfView graphs are supported.

EXSPI MBOX Config: Starts the mailbox configuration program that 
automatically creates a mailbox.

For Exchange 5.5: the mailbox is created with service account as 
the owner, so the service account must be created prior to running 
the application, see Creating a Service Account with Proper Access 
Permissions chapter 2  page 22. 
The script supports two options. The syntax is:        
exspi_e2k_cfg [-m mailBoxName] [ -ou OU ]                            
-m (optional parameter) is the mailBoxName prefix.                              
-ou (optional parameter) is the Organizational Unit.                                  
If the -m parameter is not specified, the default prefix is MSXSPI. 
The mailbox enabled service account is created as 
MSXSPI<hostname>. This mailbox name is added to the 
exspi\defaults file as line MAILBOX mailBoxName.                        
If the -ou parameter is not specified, the mailbox will be created in 
the USERS container. 
By default a mailbox named MSXSPI<hostname> is created on the 
Exchange server where "hostname " is the name of the Exchange 
server. 
The mailbox is created hidden from the GAL.

EXSPI Node Config: Configures the service account with special 
Exchange privileges (MSXSPI) on the managed node. This account is 
for templates distributed in the Advanced Configuration section.

EXSPI Ping Config: Configures the Advanced Configuration 
Template: End To End Message Ping.

Self-Healing Info: This application gathers system information 
(command output, configuration, log and trace files), and writes this 
data to a file which HP support services can use during troubleshooting. 
For more information, see.Self-Healing Information for enhanced 
troubleshooting chapter 8  page 155. 

Enable Message Tracking (for Exchange 2000 and 2003 only): Turning 
message tracking on will cause the Exchange server to write tracking 
log files. The Exchange SPI track log schedule template parses these 
log files to collect data for the four tracklog reports: Exchange Top 
1 - 11
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Destinations, Exchange Top Recipients, Exchange Top Senders, and 
Exchange Top Sources.

Enable EXSPI Tracing: Enables tracing; default setting is OFF. This 
application is generally used for troubleshooting. When tracing is 
turned on the results are written to:  
%OvAgentDir%\exspi\log\trace.                                              
Note: The trace file will grow very large. It is advisable to leave tracing 
enabled only long enough to recreate the problem, or in order to comply 
with HP support instructions.

Disable EXSPI Tracing: Disables tracing; (default tracing setting is 
OFF). 

Enable Data Logging: Starts Exchange SPI data logging, the default 
setting is ON. This is normally used after Disable Data Logging, to 
restart data logging.

Disable Data Logging: Stops Exchange SPI from logging data.

Exchange Cluster Config: The Exchange Cluster Config application 
prints apminfo data, which can be used to create the apminfo.xml file 
used by the Exchange SPI to recognize clustered instances. For further 
information about Exchange SPI monitoring clusters, see Using 
Exchange SPI in high availability environments chapter 5  page 98. 
Regarding privileges: This application can be run as any account that 
has the ability to read wmi, such as a Domain admin or an Exchange 
admin account

Mount Exchange DB: This application can search for and mount 
dismounted mailboxes or public folder store databases. It requires the 
user name and password of a special account that has Exchange 
administrative privileges, as the application must be modified with this 
info before executing, see Creating a Service Account with Proper 
Access Permissions chapter 2  page 22. 

     The application can take one or all of the following parameters: 

-s    Search for dismounted databases.
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-m  Search for dismounted databases and attempt to mount any 
found.
-p   Print the output.
-a   Forward an alarm message to the OVO Management server.
-t   Timeout: the time the tool can take to re-mount a dismounted 
database (in seconds). If not provided, the script will automatically 
set the timeout value to be 5 seconds. If the database cannot be 
remounted within the time frame given, you can set a higher 
timeout value, e.g. 30 seconds. If remounting the dismounted 
database still fails, and there is not an error in the output of the tool, 
there is probably a problem with the Exchange information store 
service. 

Exchange 5.5 Exchange SPI Applications.
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Exchange 2000 and 2003 Exchange SPI Applications
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3. EXCHANGE SPI MESSAGE GROUPS AND MESSAGES

OVO Message Group Bank window

There are three Exchange SPI message groups located in the OVO Message 
Group Bank window and all messages generated by the Exchange SPI fall into 
one of these message groups. They are:

1. EXSPI: contains messages generated by Exchange-SPI programs. They 
contain instruction text to help to diagnose/remedy problems.

2. EX_Perf: contains messages regarding Exchange performance.

3. EX_Fault: contains messages regarding error conditions.

Exchange SPI messages are associated with Services in the service map.
1 - 15
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4. EXCHANGE SPI REPORTS AND GRAPHS

Exchange SPI Reports

Exchange SPI reports come in a separate package, EXSPI-Reporter.msi 
which can be found in the HP OpenView Operations for Unix Application 
CD-ROM. HP OV Reporter can be used to access the Exchange SPI data source, 
EXSPI_DATA present on the managed node and generate reports using Seagate 
Crystal Reports. These reports are broadly classified as Summary and Detail 
reports.

Summary reports show data for all servers.

Detail reports show information by system. See Reports for Exchange 
2000 and 2003 chapter 7  page 140, and Reports for Exchange 5.5 only 
chapter 7  page 143, for complete lists of out-of-the-box Exchange SPI 
reports.

Exchange SPI Graphs

Exchange SPI includes a set of preconfigured graphs that can be viewed in HP 
Perfview. PerfView graphs require that an OpenView Performance Agent (also 
known as MeasureWare Agent) is running on the managed node. Upon 
installation of Exchange SPI, these graphs are located in the Application Bank 
under: EXSPI Admin > Exchange [2000 and 2003/55] > Exchange [2000 and 
2003/55] Graphs.

The graphs are categorized as: Information Store, Messaging, System 
Information and Transaction Log File Size (Exchange 5.5 only). For more 
information, see Exchange SPI Graphs chapter 7  page 147.

In addition, data from any Exchange SPI server can be graphed using PerfView 
and data from the Exchange SPI OVO data collecting agent DSI logfiles. For 
more information, see Generating Graphs from an Exchange SPI DSI Logfile 
chapter 7  page 151.
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PerfView Graph Generated from Exchange SPI Data
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Introduction
Introduction
The Exchange SPI collects data from many sources. In order to collect the many 
types of data, the Exchange SPI requires advanced user credentials. 

This chapter outlines:

Which templates/applications have user account requirements
How to create the service account and grant proper access permissions in 
the following environments:

Exchange 5.5 nodes in a Windows NT domain
Exchange 5.5 nodes in a Windows 2000 domain
Exchange 2000/2003 nodes in a Windows 2000/2003 domain
2 - 20
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User Privileges
There are 2 levels of user privilege needed by the Exchange SPI:

1. $AGENT_USER

All templates in the Quick Start group, and some templates in the Add-Ons and 
Advanced groups, run under this type of account. No customization to templates 
is required, only threshold changes if desired. 

2. Service account user with special Exchange privileges

TEMPLATES: Some templates in the Add-Ons and most templates in the 
Advanced group run under this type of account:

EXSPI Advanced > EXSPI End to End Message Ping > EXSPI-55/60 
End to End Message Ping. These templates use the mailbox created by 
the Exchange SPI application Mailbox Config.

EXSPI Advanced > EXSPI Reporter Collection > all templates.

APPLICATIONS: The following applications need to run with this special type 
of service account:

Enable Message Tracking

EXSPI MBOX Config.
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Creating a Service Account with Proper 
Access Permissions
Some templates and applications require a service account for each logon 
domain where Exchange servers reside (see Exspi Template Group Requirements 
chapter 4  page 89). This service account enables the Exchange SPI to access 
information from the Exchange database. 

The service account must be created and the access privileges granted. 
Procedures are outlined according to operating system environment, in the 
following manner:

Case 1: For Exchange 5.5 nodes in a Windows NT Domain (Note: 
Windows NT is only supported under OVO 7).

Case 2: For Exchange 5.5 nodes in a Windows 2000 Domain

Case 3: For Exchange 2000/2003 nodes in a Windows 2000/2003 
Domain 
2 - 22



Chapter 2: User Privileges
Exchange 5.5 nodes in a Windows NT Domain
Exchange 5.5 nodes in a Windows NT 
Domain 

CREATE USER ACCOUNT 
1. Log on as Domain Administrator of the domain to which the Exchange 

server belongs. 

2. Select Start > Programs > Administrative Tools (common) > User 
Manager for Domain.

3. Select User > New User. In the dialog that appears create a new user as 
follows:

 User Manager dialog 
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NOTE: Remember this password; you will need it later to update applications and 
templates.

 New User dialog 

4. Deselect User Must Change password at Next Logon and select 
Password Never Expires.

 Username:  MSXSPI

 Full Name:  OVO Exchange SPI 

 Description:  Exchange SPI for OVO 

 Password/Confirm Password:  *********

This password must be entered but will not be authenticated 
later.
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5. Click the Groups button to display the Group Memberships window.

 Group Memberships dialog

6. At the right, from the Not a member of: box select the Domain Admins 
user, click Add, and OK to close the Group Memberships window.

7. To include necessary information, click buttons in the New User window:  

8. Click Add to add this user. (If the Exchange Add Mailbox window is 

 Profile:  No User Profile should be specified.

 Hours:  All hours of the day and week should be allowed.

 Logon To:  All workstations should be specified.

 Account:  Should never expire/should be Global Account.
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displayed, select Cancel to close it).

9. Click the Close button to close the New User window.

10. From the User Manager menu bar select Templates > User Rights....

 User Manager dialog

11. Check the Show Advanced User Rights checkbox.

12. From the drop-down list select Log on as a service in the Right field
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 Selecting Log on as a service for User Rights.

13. Click the Add button to open the Add Users and Groups window.

14. Click the Show Users button.

15. Select the user account just added (MSXSPI), click Add, then OK.
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 Adding the new User Account

16. Repeat steps 12-15 to add the Profile system performance right.

GRANT EXCHANGE ACCESS PERMISSIONS TO USER 
ACCOUNT 

In order for the user account (in this example MSXSPI) to have access to a 
mailbox as well as the Exchange IS Public and Private databases, it must have 
Exchange Admin permissions. Use Exchange Administrator to grant these 
permissions at the site level.

1. Select Start > Program > Microsoft Exchange > Microsoft Exchange 
Administrator.
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2. For each Exchange site where Advanced templates are to be distributed: 

a. In the left pane within the tree, select <site_name>.

b. From the File menu select Properties.

c. In the Properties window, select the Permission tab and click Add to open the 
Add Users and Groups window.

d. Select the user account previously created (MSXSPI), and click Add.

e. Click OK to add the user, and close the Add Users and Groups window.

f. Verify the user has the role of Admin.
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 Verifying the User role

g. Click OK to save the changes.
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Exchange 5.5 nodes in a Windows 2000 
Domain 

CREATE USER ACCOUNT

1. Log on to the system that hosts the managed node’s domain.

2. Select Start > Programs > Administrative Tools > Active Directory 
Users and Computers.

3. Expand the Active Directory of Users and Computers, right-click Users, 
and select New > User.
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 Selecting New User dialog

4. In the dialog box that appears, enter the user name just created (in this 
example MSXSPI) as the First Name and as the User logon name.
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 New object dialog

5. In the next window, enter Password/Confirm Password for the user 
account (MSXSPI).

6. Select Password Never Expires. Then click Next
2 - 33



Chapter 2: User Privileges 
Exchange 5.5 nodes in a Windows 2000 Domain
 Setting User Privileges.

7. In the New Object dialog, deselect Create an Exchange mailbox, and 
click Next.
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 Deselect Create an Exchange Mailbox

8. In the next dialog, complete creating the user by clicking Finish.

9. You are now back at the Active Directory Users and Computers dialog. 
In the right pane, right-click on the user just created (in this example 
MSXSPI) and select Properties.

10. In the MSXSPI Properties page, select the General tab. Enter “Exchange 
SPI for OpenView Operations for Windows” in the Description field.
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 Properties dialog

11. Select the Member Of tab. Click Add
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Setting User account privileges

12. In the Select Group dialog select Domain Admins from the top pane. 
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Click Add, then OK.

13. The new user (MSXSPI) is now a member of Domain Admins group. Click 
OK and exit the Active Directory Users and Computer dialog.

 New User with new Membership status
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GRANT EXCHANGE ACCESS PERMISSIONS TO USER 
ACCOUNT 

In order for the user account MSXSPI to have access to a mailbox as well as the 
Exchange IS Public and Private databases, it must have certain Exchange Admin 
permissions. Use Exchange Administrator to grant these permissions at the site 
level.

1. Select Start > Program > Microsoft Exchange > Microsoft Exchange 
Administrator.

2. For each Exchange site where Advanced templates are to be distributed:

a.. In the left pane within the tree, select <site_name>.

b. From the File menu select Properties.

c. In the Properties window, select the Permission tab and click Add to open the 
Add Users and Groups window.

d. Select the user account previously created (MSXSPI), and click Add.

e. Click OK to add the user, and close the Add Users and Groups window.

f. Verify the user has the role of Admin.
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 Verifying User roles.

g. Click OK to save the changes.
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Exchange 2000/2003 nodes in Windows 
2000/2003 Domain 
To create a service account with special Exchange privileges for Exchange 
2000/2003 nodes the following steps are required:

Enable viewing of the Administrative Groups folder

Create the service account

Add the service account user to the Local Administrators group.

ENABLE VIEWING OF ADMINISTRATIVE GROUPS FOLDER

To create the user account it is necessary to first enable viewing the 
administrative groups folder:

1. Open the Exchange server Properties

2. Select Display administrative groups.

3. Click Apply and OK.
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Exchange Server Properties Dialog
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CREATE USER ACCOUNT

1. Log on to the system that hosts the managed node’s domain.

2. Select Start > Settings > Control Panel > Administrative Tools > Active 
Directory Users and Computers.

3. Expand the Active Directory Users and Computers and right-click Users 
and select New > User.

Active Directory Users and Computers dialog

4. In the New Object - User dialog, enter a user name for the new service 
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account into the First Name and the User logon name fields.  

Entering the new service account name   

5. In the next window, enter Password/Confirm Password for the service 
account.

6. Select Password Never Expires. Then click Next.

You must create a service account with these privileges in each Windows domain. 
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Setting password properties   

7. In the New Object dialog, deselect Create an Exchange mailbox, and 
click Next
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Deselecting creating a mailbox   

8. In the next dialog, complete creating the user by clicking Finish.

9. You are now back at the Active Directory Users and Computers dialog. 
In the right pane, right-click on the service account user just created and 
select Properties.

10. In the service account Properties page, select the General tab. Enter OVO 
Exchange SPI in the Display name and Description fields.
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Entering names in Properties dialog   

11. Select the Member Of tab, and click Add.

12. In the Select Group dialog select Exchange Domain Servers from the top 
pane.

13.  Click OK and exit the Active Directory Users and Computer dialog.
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Confirming membership privileges   

14. Add the service account user to the Local Administrators group on the 
Exchange server. 

a. On each targeted Exchange 2000/2003 server, select Start > Settings > 
Control Panel. 
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b. Double click Administrative Tools. Double click Computer 
Management, then open the Local Users and Groups folder. Select 
and open the Groups folder, then double click Administrators.

c. In the Administrators Properties dialog, click the Add button. Select the 
correct Domain from the Look in drop down list. Select the new service 
account user from the list, and click Add. Click Apply and then OK.

 Adding service account user to Local Administrators group
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NOTE: It can sometimes take a few hours for new group membership and rights to be 
applied to a service account
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Introduction
Introduction
This chapter offers instructions for installing, configuring and removing 
Exchange SPI components. It covers the following topics:

Prior to installing Exchange SPI
Installing and configuring the Exchange SPI

Template Groups: installation considerations

Installation and Basic Configuration

Advanced Configuration

Removing the Exchange SPI
Deleting Exchange SPI templates, applications and message groups. 
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Prior to Installation
This release is targeted at OVO for UNIX 7.x or higher. Please verify 
your current OVO version.

Before installing this version of the Exchange SPI, any previous version 
of the Exchange SPI must be removed, see Deinstalling Exchange SPI 
chapter 3 page 81.

The installation of Exchange SPI depends on the following pieces of 
software, verify that they are present on the management server before 
installing the Exchange SPI: 

DSI2DDF A.01.30.00 or higher (for OVO7 and OVO8/DCE) 
A.02.00.00 or higher (for OVO8/HTTPS).

SPI-SHS-OVO (version = A.01.00).

Every installation of the Exchange SPI requires a basic configuration 
procedure which is detailed in the section Installation and Basic 
Configuration chapter 3 page 55.

A more advanced configuration procedure is required before 
distributing some of the Add-Ons and Advanced templates, for example 
those for collecting Exchange folder and mailbox information, and 
testing connections between servers. See Advanced Configuration 
chapter 3 page 65 for the advanced configuration procedures.

Some templates require a service account with special Exchange 
privileges. See Exspi Template Group Requirements chapter 4 page 89 
for template requirements, and see Creating a Service Account with 
Proper Access Permissions chapter 2 page 22 for procedures. 

Exchange SPI requires a data collection agent - OpenView Performance 
Agent [also known as MeasureWare Agent] or OpenView Operations 
Subagent 12 [included with OpenView Operations 7.0 and 8.0], to 
collect data for reporting and graphing purposes. Use the Exchange SPI 
application EXSPI Add DataSource to configure the data source and 
3 - 53



Chapter 3: Installation & Configuration 
Prior to Installation
start logging data. 

Exchange SPI graphs require HP OpenView PerfView. Exchange SPI 
reports require HP OpenView Reporter, and the Exchange SPI 
EXSPI-Reporter.msi must be installed on a Windows node in the same 
domain where Exchange SPI is managing nodes.

TEMPLATE GROUPS: INSTALLATION CONSIDERATIONS

After installation, you can view the Exchange SPI templates using the 
Templates>Reload Templates command in the Message Source Templates 
window. 

NOTE: In OVO for UNIX version 8.0 and later, templates are referred as policies.

Exchange SPI templates are located under the SPI for Exchange group and can 
be distributed as groups or individually. The groups are as follows:

SPI for MS Exchange: under this folder are the version specific 
folders Exchange 55, and Exchange 2000 and 2003. Template groups 
are prefixed with 55 for Exchange 5.5 and 60 for Exchange 2000 and 
2003. The requirements for each group are as follows: 

• EXSPI-xx-Quick Start templates, in general require the HP ITO 
Account, see Exspi Template Group Requirements chapter 4 page 
89.

• EXSPI-xx-Add-Ons templates are designed to monitor specific 
software components, which may or may not be installed on the MS 
Exchange Server (for example, Lotus Notes must be installed for the 
EXSPI-60 Lotus Notes Connector templates to work). Select 
templates for the software components you are using on the targeted 
MS Exchange Server.

• EXSPI-xx-Advanced templates and EXSPI-xx-Add-Ons generally 
require a service account with special Exchange privileges. See 
Creating a Service Account with Proper Access Permissions chapter 
2 page 22 for details.
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All data collection templates require that a data collection agent (the OV 
Performance or OVO subagent) is installed and running on the managed node. 

Installation and Basic Configuration
The Basic Exchange SPI configuration is designed to get you started quickly, 
using the Quick Start template group that requires only the HP ITO Account as a 
basis for server monitoring. Many of the templates in the Add-Ons and 
Advanced template groups require a service account with special Exchange 
privileges, which requires the more Advanced configuration procedure covered 
later in this chapter. 

When the basic installation and configuration procedure is complete, you will 
have completed the following tasks: 

Task 1: Install Exchange SPI on the management server.
Task 2: Add nodes to the node group EXSPI.
Task 3: Install OVO agents on all MS Exchange server systems (required 
if the OVO Windows agent is not yet distributed).
Task 4: Install OVO agents on the management server (needed for some 
of the OV utilities that are used by Exchange SPI applications).
Task 5: Assign responsibilities for the OVO Operator.
Task 6: Distribute Exchange SPI actions, commands, monitors to the 
Exchange servers. 
Task 7: Run the EXSPI Add Data Source application, and configure data 
sources.
Task 8: Assign and distribute Quick Start template groups to managed 
nodes running MS Exchange server.

TASK 1: INSTALL EXCHANGE SPI ON MANAGEMENT SERVER

Prerequisite: It is not necessary to stop OVO sessions before beginning the 
Exchange SPI installation, however the following need to be installed on the 
management server:

OpenView Operations (OVO) for UNIX version 7.x or higher
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DSI2DDF A.01.30.00 or higher for OVO7 and OVO8/DCE, and 
A.02.00.00 or higher for OVO8/HTTPS.

NOTE: The instructions that follow show the command line usage of swinstall. For 
HP-UX systems you can also use the graphical user interface (GUI), but the 
procedure is not covered here.

The Exchange SPI is available on the HP OPenView Operations for UNIX 
Applications CD-ROM. There are two CDs in the Applications CD-ROM set, the 
first contains the products’ management server install packages, and the second 
contains the OpenView Reporter and OpenView Performance Manager 
integrations for the applications. At this point use the first CD.

For an HP-UX 11.0 management server, enter:

swinstall -s /cdrom/OV_DEPOT/11.OHPUX.sdtape SPI-EXCHANGE-OVO

For a Solaris management server, enter:

swinstall -s /cdrom/OV_DEPOT/SOLARIS.sdtape SPI-EXCHANGE-OVO

TASK 2: ADD NODES TO THE NODE GROUP EXSPI

Upon installation Exchange SPI creates a Node Group EXSPI. All Exchange 
nodes to be managed should be added to this node group, so that tasks such as 
installing agent software, running applications, and distributing 
actions/commands/monitor/templates can be done for the whole node group, 
instead of needing to select each node.

TASK 3: INSTALL OVO AGENTS ON MS EXCHANGE 
SERVERS

Install an OVO Windows agent on all MS Exchange servers. (If you need details 
for installing the OVO agent, refer to the OVO Installation Guide for the 
Management Server.) 
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TASK 4: INSTALL OVO AGENT ON OVO MANAGEMENT 
SERVER

Install an OVO UNIX agent on the OVO Management Server. (For details on 
installing the OVO agent, refer to the OVO Installation Guide for the 
Management Server.)

NOTE: This is required for the Exchange SPI applications that run on the management 
server.

TASK 5: ASSIGN RESPONSIBILITIES FOR OVO OPERATOR

All target hosts for Exchange SPI must be OVO managed nodes and must be 
running on an OVO intelligent agent. 

1. Log on to OVO as the OVO administrator (opc_adm).

2. Select Window > User Bank
a. Select the opc_adm user
b. Choose Actions > User > Modify
c. Press the Responsibilities button and use the Responsibilities for Operator 
(opc_adm) window to view messages.
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The Responsibilities for Operator window

3. In the Node Group that contains your Exchange managed node, select the 
following Exchange SPI message groups:

EXSPI
EX_Fault
EX_Perf

4. Use the Actions > Browser > Start/Reload from the OVO User Bank menu.

TASK 6: DISTRIBUTE EXCHANGE SPI ACTIONS, 
COMMANDS, MONITORS

To collect Exchange data, you must complete the following steps:

1. Distribute Exchange SPI actions, commands, monitors to the Exchange 
servers by selecting Actions>Agents>Install/Update SW & Config from the 
OVO Node Bank menu. 
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Install/Update OVO Software and Configuration window

2. In the Install/Update OVO Software and Configuration window check the 
following checkboxes to select components:

Actions

Monitors

Commands

3. Check the Nodes in List Requiring Update checkbox.

4. Check the Force Update checkbox.

5. If a node was not selected previously, select the node in the Node Bank and 
use Get Map Selections to add the Exchange server(s) to the target node(s) 
list.

6. Click OK.
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7. The following message is displayed in the message browser:

The following configuration information was successfully 
distributed: Actions, Commands, Monitors

TASK 7: RUN THE EXSPI ADD DATASOURCE APPLICATION 
AND CONFIGURE DATASOURCES

The OVO data collection agent collects, logs, and timestamps data from 
individual systems. If you use OV Performance Agent (MeasureWare Agent), 
you can use PerfView to graph the data; if you use OpenView Reporter, you can 
use it to generate reports displayed as Web pages.

1. At the OVO console, from the Window menu, select Application 
Bank>EXSPI Admin. 

2. To create data sources for the OVO data collection agent, run EXSPI Add 
DataSource for each managed node.
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Adding Datasource for HP OpenView Subagent (CODA)
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Adding Datasource for OV Performance Agent (MWA)
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TASK 8: ASSIGN/DISTRIBUTE QUICK START TEMPLATES

NOTE: In OVO for UNIX version 8 and later, templates are referred to as policies.

To assign and distribute templates to managed nodes:

1. Open the OVO Node Bank.

2. Select the desired managed node(s) designated to run Exchange SPI.

3. To assign (select) the templates for distribution, select 
Actions>Agents>Assign Templates from the menu bar.

4. In the Define Configuration window select Add.

5. In the Add Configuration window select Open Template Window....

6. In the Message Source Templates window double-click the SPI for 
Exchange group to display the subgroups.

7. Select, and double-click Exchange 2000 and 2003 or Exchange 5.5. 

8. Select the desired EXSPI template group or individual template(s).

9. Click Get Template Selections from the Add Configuration window.

10. Click OK from the Add Configuration window.

11. Click OK from the Define Configuration window.

The desired templates have been selected for distribution. Next, distribute 
them to the managed nodes.

12. To distribute the assigned templates, select Actions >Agents>Install/Update 
SW & Config from the Node Bank menu. 

13. In the Install/Update OVO Software and Configuration window check the 
Templates checkbox to select it.
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Distributing templates

14. Check the Nodes in List and the Force Update checkboxes.

15. If a node was not selected previously, select the node in the node bank and 
click Get Map Selections to list the target node(s), then click OK to 
distribute templates to the managed node(s).

16. The following message displays in the message browser:

The following configuration information was successfully 
distributed: Templates

You have now completed the standard Exchange SPI installation and 
configuration process. The Exchange SPI templates are distributed to the 
selected managed nodes and Exchange SPI monitors will begin running.
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Prerequisite: Complete tasks in the section Installation and Basic 
Configuration chapter 3 page 55.

Advanced configuration covers the distribution of templates that require a 
service account with special Exchange privileges. When finished, you will have 
completed the following tasks:

Task 1: Create the service account. 
Task 2: Grant Exchange access permissions to the user.
Task 3: Run the EXSPI Node Config application.and configure the service 
account on managed nodes.
Task 4: Enable message tracking.
Task 5: Run the EXSPI MBOX Config application, and create a 
MSXSPI<host_name> mailbox for each Exchange server.
Task 6: Run the EXSPI Ping Config application to configure MS 
Exchange servers for End to End Message Ping.
Task 7: Assign/distribute Add-On and Advanced templates.

The Exchange SPI can be configured to accommodate cluster environments 
where fail-overs allow uninterrupted Exchange availability, see Using Exchange 
SPI in high availability environments chapter 5 page 98 for more information.n

TASK 1: CREATE THE SPECIAL SERVICE ACCOUNT

A service account with special Exchange privileges is needed for each Windows 
logon domain where your managed Exchange servers reside. See the procedures 
in Creating a Service Account with Proper Access Permissions chapter 2 page 22 
for details on creating this type of account in Windows NT and Windows 
2000/2003 operating environments.
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TASK 2: GRANT EXCHANGE ACCESS PERMISSIONS TO 
SERVICE ACCOUNT

See the procedures in User Privileges chapter 2 page 21, where the procedures 
for granting proper access permissions for each combination of 
Exchange/Windows environment is outlined.

TASK 3: RUN THE EXSPI NODE CONFIG APPLICATION AND 
CONFIGURE SERVICE ACCOUNT ON MANAGED NODES

1. Select all the desired Exchange managed nodes. 

2. Drag these nodes and drop them on the EXSPI Node Config application 
located in the EXSPI Admin application group. 

3. When prompted, enter the domain, user and password for the user account 
(created in Task 1: Create the special service account chapter 3 page 65). 
NOTE: When you run this application, be sure to enter the correct domain 
name, user and password. This domain is not the DNS domain name but the 
NT domain name. 
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EXSPI Node configuration window

NOTE: If Exchange nodes are managed at a later date, perform this procedure for all 
newly managed Exchange nodes.

TASK 4: ENABLE MESSAGE TRACKING

To ensure that all messages routed through a server are added to the OVO 
message tracking logs you need to enable message tracking. You can record 
information about the sender, the message, and the recipient. If you need to log 
more detailed information, you can also record the subject line of the Email 
message.

4A: ENABLING MESSAGE TRACKING FOR EXCHANGE 5.5
1. Select Start > Programs > Microsoft Exchange > Microsoft Exchange 

Administrator.
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2. Expand the site level and Configuration to view selections beneath it.

3. In the details pane double-click Information Store Site Configuration.

4. In the Information Store Site Configuration Properties dialog, check 
Enable message tracking, and select OK.

 Information Store Site Configuration dialog 

5. Repeat steps 3 and 4 for MTA Site Configuration.
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 MTA Site Configuration dialog 

6.  In the left pane select Connections.

In the right pane select Internet Mail Service, check the Enable message tracking 
checkbox, and click OK.

4B: ENABLING MESSAGE TRACKING FOR EXCHANGE 2000 
AND 2003

Use the Exchange SPI application Enable Message Tracking to set message 
tracking on, for servers only. All messages that are routed through the selected 
servers will then be added to the message tracking logs. This information is 
collected by the EXSPI-60 Dc-TrackLog Data collection templates.You can 
record information about the sender, the message, and the recipient. If you need 
to log more detailed information, you can also record the subject line of Email 
messages.

If the Internet Mail Service connector does not exist, skip the following 
steps.
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The Enable Message Tracking application needs to be modified to include the 
user name and password of a service account that has Exchange administrative 
privileges. Open the Enable Message Tracking application, and add the user 
name and password.to the Execute as User field, before executing.

Enabling Message Tracking for Exchange 2000 and 2003
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TASK 5: RUN THE EXSPI MBOX CONFIG APPLICATION 
AND CREATE MAILBOXES

In addition to the MSXSPI user, a mailbox is required for accessing mailbox and 
folder information, necessary for End to End Message Ping and Reporter 
Collection templates. Use the Exchange SPI application MBOX Config (located 
in the EXSPI Admin application group) to create the mailbox:

1. Modify the MBOX Config application. The user name and password of a 
service account with Exchange administrative privileges needs to be given 
for the application to execute. (Change the Execute as User field, add user 
name and password.) 

2. Run the EXSPI MBOX Config application to configure mailboxes for the 
Exchange servers (you can select multiple nodes simultaneously).

For each Exchange server a mailbox is created with the prefix MSXSPI and 
Windows hostname. For an Exchange 5.5 server, EXSPI MBOX Config 
application creates a mailbox MSXSPI<host_name> for the primary Windows 
account MSXSPI. For an Exchange 2000 or 2003 server, it creates the mailbox 
MSXSPI<host_name> for account MSXSPI<host_name> (which it also 
creates.)

For example, for the node rosspi4.rose.hp.com (Internet name) and Windows 
name ROSSPI4 a mailbox is created called MSXSPIROSSPI4. 

NOTE: In order to create a different mailbox with a different name, see the procedure 
Changing the Mailbox name chapter 6 page 120.
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MBox Config application output

NOTE:
If you receive an error in the above step or you cannot automatically create 
mailboxes, you must manually complete the following on each Exchange 
server:

For each Exchange server create a mailbox with the prefix MSXSPI 
and Windows hostname.

For Exchange 5.5, create this mailbox with primary Windows 
account MSXSPI. 

For Exchange 2000 or 2003, create this mailbox with primary 
Windows account MSXSPIROSSPI4 (this must first be created).
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TASK 6: SET UP MESSAGE PING SERVER CONNECTIONS 
AND ALARMS 

To measure the round trip time required for a message to travel from one server 
to another and then back to the originating server, you can use the EXSPI-60/55 
End to End Message Ping template group. 

NOTE: With Exchange SPI version A.08.00 and later, pinging Exchange 5.5 servers 
from an Exchange 2000/2003 server, or vice versa, is not supported.

Before you can use the End to End Message Ping templates, you must configure 
the pair of servers that you want to test. 

For Exchange 5.5 servers:

To configure the servers, complete the following steps:

1. Run the EXSPI Ping Config application on the OVO management server. 

The EXSPI Ping Config application opens a default file as follows: 
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Format of the file for Exchange 5.5 EXSPI Ping Config
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2. Enter information about the servers to replace each entry separated by a 
colon (:) in the format 
Src-Srv:Src-MB:::Dest-MB:Timeout:MetSLA:AlmostMetSLA 

Source Server - The server that the ping originates from. Each 
server where EX-SPI is distributed has the same file, so the EX-SPI 
collector/analyzer will parse this file and use all lines where the 
Source Server matches the server where it is run from.

Destination Server - The destination server, used only for SMTP 
systems, is necessary only when the site directory does not contain 
the destination mailbox. In this case, SMTP is used and the field 
would contain the SMTP server name (the server following the 
"@"; for example, the entry for mailbox 
"brendan_belcastro@am.exch.hp.com", would contain 
"am.exch.hp.com." 

Destination Mailbox (required) -The mailbox to send the ping to. 
This field is usually the only required destination entry.

Timeout (required) (s-seconds, m-minutes, h-hours): - If a sent 
message does not return in the defined timeout interval, EXSPI logs 
it as a failure and sends a message to OVO. Failed messages are 
tallied in terms of count and percentage within a report. The 
timeout value must be larger than the values for MetSLA and 
AlmostMetSLA so that a returned message can be processed using 
these values. It may have Exceeded SLA even though it has not 
exceeded the timeout interval. A Failed/Timedout message occurs, 
therefore, only when the message never returns and the timeout 
period is exceeded.

NOTE The minimum timeout value should be set slightly less than the collection 
interval. For example, if the collection interval for metric 1002 is 30 minutes 
(the default), the timeout should be set to at least 25 minutes. The logic is that 
because the next measurement occurs only every 30 minutes, you should allow 
up to that amount of time for any messages to return before "giving up" and 
generating a failure. If you keep the timeout value within the collection interval 
and the reply message does return, it can be processed as Met, Almost Met or 
Exceeded as opposed to Failed/Timedout.
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MetSLA (required for reports) (s-seconds, m-minutes, h-hours) -   
If the round trip time is greater than this value, the message is 
logged as either Almost Met SLA or Exceeded SLA. This value is 
required if data is being sent to MeasureWare Agent DSI for 
reporting (-l option when running exspi_e2k.exe or exspi_e55.exe). 
It is optional if only using alarms.

AlmostMetSLA (required for reports) (s-seconds, m-minutes, 
h-hours) - If the round trip time is greater than the MetSLA value 
but less than or equal to MetSLA plus AlmostMetSLA, the message 
is logged as Almost Met SLA. Otherwise, when the round trip time 
is higher than MetSLA plus AlmostMetSLA, it is logged as Clearly 
Exceeded SLA. This parameter is required if data is being logged to 
MeasureWare Agent DSI (-l option when running exspi_e2k.exe or 
exspi_e55.exe), optional if only using alarms.

NOTE Timeout, MetSLA, and AlmostMetSLA values can have optional identifiers that 
denote the measurement units the value represents; for example, 4m (4 minutes) 
30s (30 seconds) or 1h (1 hour). The default unit is seconds; for example, the 
entry 4 is recognized as 4 seconds.

Procedure for EXSPI Ping Config for Exchange 2000/2003 servers
1. Select the Exchange managed nodes that you wish to configure in the VPO 

Node Bank.

2. Drag these nodes and drop them on the EXSPI Ping Config application 
located in the EXSPI Admin application group, under the appropriate 
Exchange version.

3. A window appears with the configuration file, as shown in the figure below.

4. Edit the file as necessary, then click Esc.

5. You will be prompted to save the configuration. Accept the default choice 
[Yes].

6. A validation will be performed to check if the Timeout is greater than the 
sum of MetSLA and AlmostMetSLA. After validation, you will be 
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prompted to accept and install the configuration file in the monitors 
directory: 
/var/opt/OV/share/databases/OpC/mgd_node/customer/ms/nt/monitor/

7. You have completed configuring the end-to-end Ping, now distribute 
monitors to the required EXSPI managed nodes. For details about 
distributing the monitors, see Task 6: Distribute Exchange SPI actions, 
commands, monitors chapter 3 page 58.

The format of the Exchange 2000/2003 EXSPI Ping Config file is:

Src-Srv:Dest-Srv:Timeout:MetSLA:AlmostMetSLA

The user only needs to fill in the following fields:

Src-Srv

Dest-Srv

Timeout (to be entered in seconds, with no suffix)

MetSLA (to be entered in seconds, with no suffix)

AlmostMetSLA (to be entered in seconds, with no suffix).
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EXSPI Ping Config for Exchange 2000 and 2003

Set Up Different Conditions/ Thresholds for Different Server Pairs
   Using OVO Object Field & Alarming 

   (OVO High Level Expertise Recommended)

Alarms can be set to occur with metric EXSPI-60 1002 (Ping). Because you may 
need to set different thresholds for multiple server pairs, the following examples 
are offered. The examples show the syntax to insert in the template Conditions, 
using the OVO object pattern fields so that you can set differing thresholds. 
Metric 1002 sends the "FromMailbox,ToMailbox" in the object pattern fields 
with the following definitions:

FromMailbox = FromServer:FromMailbox
ToMailbox    = [ToServer]:ToMailbox
where [ToServer] is optional
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For example:

Config Entry Object

EXCH1:MSXSPIEXCH2:25m:1m:1m EXCH1:MSXSPIEXCH1,:MSXSPIEXCH2
EXCH1:MAILBOXEXCH1:
MAILOXEXCH3:2h:5m:2m

EXCH1:MAILBOXEXCH1,:MAILOXEXC
H3

EXCH2:MAILBOXEXCH2:
MAILOXEXCH4:1h:20m:10m

EXCH2:MAILBOXEXCH2,:MAILOXEXC
H4

EXCH3:MSXSPIEXCH3:EXCH4.AM.HP.COM
:
MSXSPIEXCH4:25m:5m:5m

EXCH3:MSXSPIEXCH3,EXCH4.AM.HP.C
OM:
MSXSPIEXCH4

ConditionName & 
Type

Condition Object Pattern Threshold Explanation

EXSPI-60 1002.1
+Message on 
Matched Condition

EXCH1:MSXSPIEXCH1,:
MSXSPIEXCH2

120 Threshold condition for 
ping between System 
EXCH1 and mailbox 
MSXSPIEXCH2 on 
system EXCH2. Object 
pattern is case 
sensitive.

EXSPI-60 1002.2
+Message on 
MatchedCondition

EXCH1:MSXSPIEXCH1,:
MSXSPIEXCH3

240 Threshold condition for 
ping between System 
EXCH1 and mailbox 
MSXSPIEXCH3 on 
system EXCH3. Object 
pattern is case 
sensitive.

EXSPI-60 1002.3
-Suppress
Matched Condition

EXCH1:MSXSPIEXCH1,:
MSXSPIEXCH2
EXCH1:MSXSPIEXCH1,
:MSXSPIEXCH3

If the threshold was not 
exceeded for these two 
system pairs, you must 
suppress the message if 
either of these system 
pairs gets past 1002.1 
or 1002.2.

EXSPI-60 1002.4
+Message on
Matched Condition

60 A blank object pattern 
to catch all remaining 
system pairs.
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TASK 7: ASSIGN/DISTRIBUTE ADVANCED/ADD-ON 
TEMPLATES

After completing the advanced configuration steps, you can assign and distribute 
templates from the EXSPI Advanced and Add-On template groups to the 
managed node(s) running MS Exchange server. Please refer to Task 8: 
Assign/Distribute Quick Start Templates chapter 3 page 63 for procedures.

The EXSPI Advanced template groups contain two logfile templates which 
capture Exchange warning and information events. Because Exchange generates 
numerous warning and information events, you might want to assign these 
templates only for troubleshooting Exchange: 

Logfile EXSPI-60/55 Exchange Information

Logfile EXSPI-60/55 Exchange Warnings

You have now completed the advanced configuration installation process. The 
Exchange SPI is ready to use.
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Deinstalling Exchange SPI
This process completely removes the Exchange SPI installation from the OVO 
management server. Any customized templates or copies of Exchange SPI 
default templates residing in other OVO template groups should also be 
removed. 

To reinstall Exchange SPI components with the original factory settings, see 
Returning to original factory settings chapter 6 page 121.

Follow these steps in order to ensure a proper removal of the Exchange SPI:

REMOVING EXCHANGE SPI SOFTWARE FROM THE 
MANAGEMENT SERVER

NOTE:The swremove program removes the files from the file system only. The 
following components must be deleted manually:

EXSPI Admin group must be removed from the Application bank 
(see steps 9-12 in Deleting Exchange SPI templates, applications 
and message groups section below).

EXSPI, EX_Perf and EX_Fault must be removed from the OVO 
Message group bank (see step 5 in Deleting Exchange SPI 
templates, applications and message groups section below).

EXSPI templates need to be deleted (see steps 1-4 in Deleting 
Exchange SPI templates, applications and message groups section 
below). 

1. Open a terminal window and log on as root.

2. In the terminal window run swremove by entering:
/usr/sbin/swremove SPI-EXCHANGE-OVO
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DE-ASSIGNING EXCHANGE SPI TEMPLATES FROM 
MANAGED NODES

After successfully removing the Exchange SPI from the management server 
using swremove, follow these steps to remove Exchange SPI templates from 
your managed nodes:

1. Open the OVO Node Bank.

2. To deassign the templates from the node, select Actions>Agents>Assign 
Templates from the menu bar.

3. In the Define Configuration window select all Exchange SPI templates or 
template groups, including any user-customized templates.

4. Click Remove Templates.

5. Click OK.

REMOVING EXCHANGE SPI FROM MANAGED NODES

After successfully removing the Exchange SPI from the management server 
using swremove, follow these steps to remove the Exchange SPI software from 
your managed nodes:

1. Select Actions: Agents>Install/Update SW & Config from the menu bar.

2. Check the following checkboxes to select these components for removal:

Templates
Actions
Monitors
Commands

3. Click the Nodes in List Requiring Update button.

4. If you did not select a node previously, click the Get Map Selections button 
to list the target node(s).
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5. Click the Force Update button.

6. Click OK. The following message appears in the message browser:

The following configuration information was successfully 
distributed:

Templates Actions Commands Monitors

The Exchange SPI templates and software have now been removed from the 
selected managed node(s). The Exchange SPI templates still reside in the OVO 
data repository and must be deleted manually. Continue with Deleting 
Templates, Applications and Message groups from the management server 
chapter 3  page 83.

DELETING TEMPLATES, APPLICATIONS AND MESSAGE 
GROUPS FROM THE MANAGEMENT SERVER

After successful completion of swremove, Exchange SPI templates and certain 
applications (EXSPI admin group) and message groups (EXSPI EX_Perf and 
EX_Fault), must be deleted manually. 

1. To delete the Exchange SPI Message Source templates, select Window: 
Message Source Templates from the menu bar.

2. Open all Exchange SPI template groups and use SHIFT+click to select all 
templates for deletion.

3. Select Delete from All to delete the templates.

4. Click Yes to the message: Do you really want to delete the 
template(s)?

5. To delete from the EXSPI messages group, from the menu bar select 
Window>Message Group Bank.

6. Select the EXSPI EX_Perf and EX_Fault message groups.

7. From the menu bar select Actions>Message Group>Delete.
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8. Click Yes to the message: Do you really want to delete the 
message groups? 

9. To delete any Exchange SPI application groups and their contents, select 
Window: Application Bank from the menu bar.

10. Select all Exchange EXSPI Admin Applications and Graphs.

11. From the menu bar select Action>Application>Delete.

12. Click Yes to the message: Do you really want to delete the 
application groups.
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Introduction
Like all HP OpenView SMART Plug-Ins, the Exchange SPI is easy to use. This 
chapter describes some special usage features and functionality, including:

Daily Tasks
Exchange SPI template group requirements
Changing the OpenView data collection agent setup
Command Line Parameters
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Daily Tasks
A daily task list for monitoring with the Exchange SPI follows:

1. Use the OVO message browser to watch for warning and critical messages 
or multiple alarms. Read the associated instruction text.

2. Adjust alarm thresholds if too many alarms are being generated (see 
“Customize the Threshold” later in this chapter).

3. Use the OVO graphing and reporting applications to drill down for 
additional information, or to view history or trends.

4. Check the active Message Browser frequently. Note the message group a 
metric belongs to:

EXSPI. Messages generated by EX-SPI programs.They contain 
instruction text to help to diagnose/remedy problems.

EX_Perf. Messages regarding performance.

EX_Fault. Messages regarding error conditions.

5. Click Perform Action (if available) from the message or message 
browser to automatically perform a pre-defined operator action. Click 
Details from the message or message browser to view details of the set 
action.
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6. Click Instructions from the message browser or the message itself to 
read and follow suggested instructions to help diagnose/remedy problems 
(see example below).

Sample Instruction Text from Exchange SPI Alarm Message

7. Use MeasureWare Agent to export data if desired. Consult the 
MeasureWare Agent User’s Guide for details.
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Exspi Template Group Requirements

NOTE: Important Microsoft Information on the Web: Before you distribute Exchange 
SPI templates, please refer to the Microsoft article “PRB: Performance Object Is 
Not Displayed in Performance Monitor” at this URL: 
http://support.microsoft.com/support/kb/articles/Q248/9/93.ASP. The article 
contains information on editing the Windows registry so that performance objects 
(tracked by Performance Monitor) are always enabled. A disabled performance object 
could cause an Exchange SPI template to fail. By following the instructions in the 
article, you can ensure that templates are able to collect Exchange performance data as 
expected. 

Some templates in the SPI for Exchange template groups require that particular 
software components/services are installed on Exchange server systems before 
the distributed templates will work, and some require the existence of a service 
account with special Exchange privileges. To create such an account, see 
Creating a Service Account with Proper Access Permissions chapter 2  page 22.

Use the following tables to decide which templates you want to install. In the 
template prerequisites table you can see whether or not a template 
group/subgroup works with Exchange 5.5, Exchange 2000 or Exchange 2003, as 
well as any required configuration. Template Group Descriptions show you what 
type of data/functionality the template group offers.

NOTE: In OVO for UNIX version 8.0 and later, templates are referred as policies.
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Table 1: EXSPI Template Group Prerequisites for Exchange 5.5  
EXCHANGE 5.5
Template Group/ Subgroup

Required 
Exchange 
Service

Required Manual Configuration

EXSPI-55 Quick Start N/A N/A

EXSPI-55 Add-Ons

EXSPI cc:Mail Connector

cc:Mail Connector N/A

EXSPI Internet Mail Services Internet Mail 
Service (IMS)

N/A

EXSPI Lotus Notes Connector Lotus Notes 
Connector

N/A

EXSPI News Service N/A N/A

EXSPI-55 Advanced

EXSPI End to End Message Ping

Create MSXSPI service account with 
correct permissions

Edit the MBOX Config Application to 
contain User Password

Create mailbox using MBOX Config 
application

Configure EXSPI End to End Message 
Ping template to set up server pairs

EXSPI Event Log Warnings & 
Information

Use for troubleshooting

EXSPI Reporter Collection Create MSXSPI service account and 
password
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Table 2: EXSPI Template Group Prerequisites for Exchange 2000 and 2003
Exchange 2000 and 2003
Template Group/ Subgroup

Required 
Exchange 
Service

Required Manual Configuration

EXSPI-60 Quick Start 
All templates

N/A N/A

EXSPI-60 Add-Ons
EXSPI cc:Mail Connector

cc:Mail 
Connector

N/A

EXSPI Chat Service (Exchange 
2000 only) 

Exchange Chat 
Service

N/A

EXSPI Conferencing Service 
(Exchange 2000 only) 

Exchange 
Conferencing 
Server

N/A

EXSPI MCU Server (Exchange 
2000 only)

MCU Server N/A

EXSPI Instant Messaging 
(Exchange 2000 only) 

Exchange Instant 
Messaging 
Service

Some templates in this group 
require the creation of a service 
account (see Advanced 
Configuration chapter 3  page 65.).

EXSPI Lotus Notes Connector Lotus Notes 
Connector

N/A

EXSPI NNTP Network News 
Transfer 
Protocol (NNTP)

N/A

Transaction Log Some templates in this group 
require the creation of a service 
account (see Advanced 
Configuration chapter 3  page 65.).
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EXSPI-60 Advanced
EXSPI End to End Message Ping

N/A For each node where the template is 
to be distributed:
Create MSXSPI service account 
with correct permissions
Edit the MBOX Config application 
to add the User Name and Password 
of the service account.
Create mailbox using MBOX 
Config application.
Edit Enable Message Tracking to 
add the User Name and Password 
of the service account.
Configure EXSPI End to End 
Message Ping template to set up 
server pairs.

EXSPI Event Log Warnings & 
Information

N/A Use for troubleshooting

EXSPI Reporter Collection N/A Create MSXSPI service account 
and password

Exchange 2000 and 2003
Template Group/ Subgroup

Required 
Exchange 
Service

Required Manual Configuration
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Changing the Data Collection Agent Setup
The HP OpenView Exchange SPI can detect whether or not you are using 
OpenView Performance Agent (also known as MeasureWare Agent). If you are, 
your new Exchange SPI installation will automatically use it as well. As a result, 
if you use PerfView, your new installation also supports that configuration. 

If for any reason you decide that you want to use the new HP OpenView 
subagent included with OVO 7.0 or 8.0, you can configure managed nodes to do 
so. Note that this configuration does not support PerfView. 

To override the use of OpenView Performance Agent, set up an empty file 
named nocoda.opt and store it on the managed node in a specific location. The 
location will vary according to the managed node operating system as shown 
below.

To create the File: 

1. (If necessary) on the managed node according to the path shown in the 
preceding table, create the dsi2ddf directory. 

2. Use a text editor to open a new file.

3. Save the file as nocoda.opt in the managed node’s dis2ddf directory.

Managed Node O/S  File Location

HP-UX and Solaris /var/opt/OV/conf/dsi2ddf/nocoda.opt

Windows \usr\ov\conf\dsi2ddf\nocoda.opt
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Command Line Parameters
The collector/analyzer executable exspi_e2k.exe can be used with the following 
command line parameters:

Parameter Description

-m <metric range> -m (metric range) is used to specify the metric 
number or range of metric numbers.

-t <tag> -t (tag) allows the collector/analyzer to use a 
different set of templates than those originally 
provided with the Exchange SPI when collecting 
metrics.
NOTE: Additional information about the tag 
feature is found at the end of the “Customizing 
Exchange SPI” section.

-p -m <range> [-v] -p (print) executes specified metrics and prints their 
values to standard output, for example:
<exspi_e2k.exe or exspi_e55.exe> -p -m 1-1001

-a -a directs the collector/analyzer to send the metric 
value to OVO for alarm generating

-s -s executes the collector as the special service 
account user (MSXSPI). Requires completion of the 
advanced configuration (see Advanced 
Configuration chapter 3  page 65).
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-l -m <metric range> 
-x <extended_option> 

Data collection metrics start at 0500. Types:
Value: logs the actual value
Delta: logs the difference between current and 
previous
Average: logs the average over a specific interval 
(e.g. 1h)
where:
-l collector logs data to logfile instead of reporting it 
to OVO
-x <extended_option> is one of: 
 logtype: is either "value, delta, or avg"
 logfreq: can only be "hourly" and is used only  
with "avg"
 runfreq: tells the collector the interval in seconds. 
If the schedule interval of EXSPI is every 10 
minutes, the runfreq option must be set to 10*60 = 
600: -x runfreq=600. The runfreq option can only be 
used with "avg."
 mbox: followed by "=<mailbox_name>" allows 
specification of certain mailboxes with certain 
metrics, specifically metrics:
611,612,622,623,630,631,632,640 and 641 
Example of a command line using this option:  
exspi -p -m 611 -x mbox=obrab

Parameter Description
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Using Exchange SPI in high availability 
environments
The Exchange SPI can be configured to accommodate cluster environments 
where fail-overs allow uninterrupted Exchange availability. 

Synchronized with the cluster environment, Exchange SPI monitoring can be 
made to switch off for the failed node and switch on for the active node. 

For recognizing clustered Exchange instances, Exchange SPI relies on XML 
configuration files. These files allow the OVO agent to automatically enable 
instance monitoring on the currently active node after disabling instance 
monitoring on the inactive node.

The Exchange SPI setup for a cluster environment requires the following steps: 

Add the nodes to be managed.

Modify, if necessary, the Exchange SPI monitoring configuration file 
included with the Exchange SPI (msexchange.apm.xml).

Create the clustered application configuration file (apminfo.xml) that 
associates Exchange SPI-monitored instances (Exchange virtual 
servers), with their corresponding cluster resource groups.

Restart the agent on the managed node.

Step 1: Add the Exchange Cluster nodes to be managed.

Add the Exchange cluster nodes to be managed. 

Step 2: Modify the Exchange SPI monitoring configuration file (if 
necessary)

The Exchange SPI includes a monitoring configuration file, 
(msexchange.apm.xml), which is an XML file that describes the templates 
that should be cluster-aware.
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The (msexchange.apm.xml file works in conjunction with the clustered 
application configuration file (apminfo.xml) that you need to create for 
your Exchange cluster.

The purpose of the Exchange SPI msexchange.apm.xml file is to list all the 
Exchange SPI templates on the managed node, in order that these templates can 
be disabled/enabled, as appropriate, for inactive/active managed nodes. 

Step 3: Create the clustered application configuration file

Apminfo.xml is an XML file that describes the cluster instances (Exchange 
virtual servers).

Apminfo.xml, working in conjunction with the Exchange SPI monitoring 
configuration file (msexchange.apm.xml), allows you to associate 
Exchange SPI monitored instances (Exchange virtual servers) with their 
associating cluster resource groups. As a result, when a resource group is moved 
from one node in a cluster to another node in the same cluster, monitoring stops 
on the failed node and starts on the new node.

NOTE: The Exchange SPI msexchange.apm.xml file is normally ready to 
use with no configuring. However, if you have renamed any templates, 
you need to modify the file accordingly. The file is in the monitor 
directory on the management server. After modifying this file, you 
need to redistribute the monitors to the Exchange nodes that are part of 
the Exchange cluster.

NOTE: If the Exchange Cluster is managed under OVO 8 / HTTPS then 
msexchange.apm.xml needs to be manually copied from:

$OvDataDir\bin\instrumentation

to

$OvDataDir\bin\instrumentation\conf

for each managed node.
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To generate the content of this file:

a. Launch the Exchange SPI Exchange Cluster Configuration application on an 
Exchange cluster node, see ‘Exchange Cluster Configuration application” 
chapter 5 page 102.   

b. Save the generated output in a temporary file by clicking on the Save.. button.

c  Open this temporary file and remove all the lines above: 

<?xml version="1.0" ?>

d  Save the remaining lines as the completed apminfo.xml file. 

If the node is managed under OVO 7 and OVO 8 / DCE, save it to:

%OvAgentDir%\conf\OpC

If the node is managed under OVO 8 / HTTPS.save it to:

<OVO_DATADIR>\conf\conf

Note: You can get the full path name for OVO_DATADIR by running the 
following command from a CMD window on the managed node: 

opcagt -type -verbose

Step 4: Restart the agent on the managed node

After constructing and saving apminfo.xml, stop and restart the OVO agent 
by running the following commands on each node: 

opcagt -kill
opcagt -start 
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Example apminfo.xml file

The following is an example apminfo.xml file, where ExchResGroup1 and 
ExchResGroup2 are the names of the Exchange resource groups 
corresponding to EXCHVIRTSERV1 and EXCHVIRTSERV2 instances 
(virtual servers):

<?xml version="1.0" ?>
<APMClusterConfiguration>
  <Application>
    <Name>msexchange</Name>
      <Instance>
         <Name>EXCHVIRTSERV1</Name>
         <Package>ExchResGroup1</Package>
       </Instance>

<Instance>

<Name>EXCHVIRTSERV2</Name>
         <Package>ExchResGroup2</Package>
       </Instance>

  </Application>
</APMClusterConfiguration> 
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Example Exchange resource group   

EXCHANGE CLUSTER CONFIGURATION APPLICATION

Use the Exchange Cluster Configuration application to generate the content of 
the apminfo.xml file. To execute this application:

1. Select all the Exchange managed nodes you wish to configure in the OVO 
Node Bank.

2. Drag these nodes and drop them on the Exchange Cluster Config 
application located in the EXSPI Admin > Exchange 2000 and 2003 
application group.

3. Use the generated output to construct the apminfo.xml. For details, 
refer to ‘Step 3: Create the clustered application configuration file” chapter 
5 page 99).
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Example output of Cluster Configuration application

NOTE: After constructing and saving apminfo.xml, you need to restart the agent on 
the node, using the following commands:

Opcagt -kill

Opcagt -start
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DATA COLLECTION ON VIRTUAL SERVERS

In order for reports and graphs to show data for any nodes, appropriate data 
collection templates need to be distributed to those nodes. See the section ‘Using 
Exchange SPI Reports and Graphs” chapter 7 page 144.

Run the Enable Message Tracking application on all nodes in the cluster before 
distributing the EXSPI 6.0 Dc-TrackingLog Data template, so that the tracking 
log reports will generate. The application must run on the physical nodes of a 
cluster where the Exchange virtual server is running.

SEEING VIRTUAL SERVERS IN REPORTS AND GRAPHS

The Exchange SPI will show Exchange virtual servers in reports and graphs as 
though they were physical Exchange servers.

SETTING UP END-TO-END MESSAGE PING ON AN 
EXCHANGE CLUSTER

Using Exchange SPI, End-to-End Message Ping can be configured on Exchange 
clusters. 

1. Run the EXSPI MBox Config application on all nodes in the cluster. The 
application must run on the physical nodes of a cluster where the Exchange 
virtual server is running on. This is a necessary step for configuring and 
distributing End-to-End Message Ping. 

2. Follow the directions in Task 6: Set Up Message Ping server connections 
and alarms chapter 3  page 73.
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WHAT HAPPENS DURING A FAILOVER:

When a failover happens, dependencies to the failed node will be removed and 
replaced with new dependencies to the newly active node. For example, if 
EXCHVIRTSERV1 moves from OVRNTTC1B to OVRNTTC1A, the 
dependencies to OVRNTTC1B will automatically be removed and will be 
replaced with a new set of dependencies to OVRNTTC1A..

NOTE: When a failover happens, messages that occurred before the failover will not be 
propagated to the virtual node

NOTE: For this mechanism to work EXSPI-60-Exchange cluster discovery Event Log 
template must be distributed.
 5-105



Chapter 5: : Clustering Support 
Using Exchange SPI in high availability environments
 5-106



6

Customizations



Chapter 6: Customizations 
Introduction
Introduction
This chapter outlines the following customization procedures:

Choosing metrics to monitor Exchange

Customizing the Exchange SPI

Basic Customization procedures
•Creating custom groupings

•Creating custom templates

•Modifying message generation

•Modifying metric template conditions

•Customizing the Threshold

•Customizing Schedules

•The Tag Feature
Advanced Customization procedures

•Changing the Windows User Account Name

•Changing the Mailbox Name
Returning to original factory settings
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Choosing metrics to monitor Exchange
Before beginning customization, first decide which metrics can remain without 
changing the thresholds, (see “Exchange SPI Metric Specifications” later in this 
chapter or the Exchange SPI Reference Manual).

NOTE It is recommended that you make a copy of the original template group and use 
the copy for customization purposes 
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Basic Customization 

Creating Custom Groupings

Create custom template groups as follows:

1. Log onto OVO as the OVO Administrator.

2. Select Window>Message Source Templates.

3. In the Message Source Templates window select the desired template group 
and click the Add... button (if Add Logfile... is displayed, pull down the 
list and select Add Group) and select a name and description for this group.

4. To copy templates to the new group:

In the Message Source Templates window, double-click to open the 
group containing the desired templates.

Select the templates to copy and choose Edit>Copy from the Message 
Source Templates menu to copy the templates.

Return to the newly created template group and choose Edit>Paste 
from the menu.
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Creating a New Template Group

Creating Custom Templates

You can create a custom template by copying an original template, making any 
desired changes, and saving it with a new name.

When the OVO environment scales, the Exchange SPI tag feature provides a 
way to partition templates into groups with each group customized in a specific 
manner. 

Modifying Message Generation 

Alarms are generated with Reset, without Reset or Continuously. 
To change the Metric Generation Type (usually in conjunction with the 
Threshold, Polling Interval and Reset value) follow these steps:

1. Select the Message Source Templates window.

2. Double-click to open the template group containing the metric to modify.

3. Click the Modify button. 
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Modifying Message Generation

4. Select one of the Message Generation types:

with Reset: Alarms are generated after the monitoring threshold has 
been exceeded. No additional alarms are generated until metrics drop 
below a specified Reset threshold and subsequently exceed the 
monitoring threshold.

without Reset: Alarms are generated after the monitoring threshold has 
been exceeded. No additional alarms are generated until metrics drop 
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below the threshold and subsequently exceed it.

Continuous: Alarms are generated continuously when metrics exceed 
the threshold.

Modifying Metric Template Conditions

Modify metric attributes as follows.

1. Select the Message Source Templates window.

2. Double-click the template group containing the metric to modify.

3. Double-click the desired metric

4. In the Message and Suppress Conditions window select the condition to 
modify and click the Modify button.
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The Message and Suppress Conditions Window

5. The Condition window displays.

The following attributes can be easily modified:

Threshold. Set the desired threshold.

Reset. This is a limit under which the object's value must drop (or exceed for 
minimum thresholds) to return the alarm state of the object to normal. 
After an object's alarm state has returned to normal, a new message can 
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be issued if the monitored parameter again exceeds (or drops below for 
minimum thresholds) the threshold value. Do not enter a value if you do 
not wish to impose a reset limit. Note that you can enter a reset value 
greater than the threshold value (or less for minimum threshold types), 
which has the same effect as if you don't specify a reset value.

Duration. Most metrics are defined as Message Generate type without 
Reset and without a Duration. Please consult the OVO Concepts 
Guide or online Help prior to modifying this field.

Severity. Click the [Severity] button and select the desired severity 
setting.

Message Text. Be careful not to modify any of the parameters in a message. 
Parameters are surrounded by <> brackets and begin with $.

Actions. This field provides the ability to add custom programs. Two types 
of actions are available: 

Operator initiated: These actions are only performed upon the 
initiation of an operator.

Automatic: These actions are performed automatically when the 
metric alarms.

NOTE Some metrics have an operator-initiated action which will display a graph if 
PerfView is installed on the management server.
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Customizing the Threshold

Customize the threshold as needed. To do so, copy the existing condition to use 
as the default, and modify the original condition to serve as the exception. 
Follow these steps:

1. Double-click the metric you want to customize (for example, 
EXSPI-60-0001). 

1. In the Message and Suppress Conditions window select the desired 
condition and select the Copy button to make a copy of the condition. 

2. Enter a name for the condition; for example, EXSPI-60-0001.3.

3. Click OK to close EXSPI-60-0001.3. This will be the default condition.

4. Select the original condition, EXSPI-60-0001.1.

5. Click the Modify button to display the Condition window.

6. In the Object Pattern field, enter the desired characters to use for pattern 
matching (see the OVO online help or the OVO Administrators Task Guide 
for pattern matching syntax).

7. Click the Test Pattern Matching… button to test the pattern and verify 
pattern matching (you must set up a match file first).

8. Change the value in the value in the Threshold field.

Testing Pattern Matching from the Condition Window
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Customizing Schedules

Schedule templates define the schedule by which the collector/analyzer will 
gather metric information. To modify a schedule template, follow these steps:

1. Select Window>Message Source Templates and double-click the template 
group containing the template to modify.

2. Double-click the desired template

3. In the Modify Scheduled Actions change any of the schedule information 
or other parameters. 

4. Click OK to close and save the changes.

5. Distribute the template to the desired managed node(s).
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Customizing a Schedule Template
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The Tag Feature

When servers are dedicated to specific sites or business units, you may find it 
more effective if those servers do not all share the same set of Exchange SPI 
templates. In such cases, the tag feature is useful in allowing you to change 
existing templates and rename them. In this way you can associate template 
assignments with specific servers and the areas with which they are associated. 
For example, you might create a business administration group of templates and 
tag those templates with “ADM-” or a branch office group and tag those with 
“BR-.”

The tag feature allows you to create custom templates in a quick way. To 
summarize the steps, you:

Make copies of existing monitor templates that you want to modify. 
(optional) Modify the monitor template settings. 
Save each modified template under the same name with a prefix.
Enter each metric and - <prefix tag> after the collector/analyzer 
command in the Program Monitor or MIB ID box of the schedule 
template.

Using this method allows the collector/analyzer to recognize a set of templates 
different from those originally provided with the Exchange SPI. This method 
allows you to enlarge the single set of templates to adjust to differing conditions 
among the servers you use.

To use this feature, make copies of the original Exchange SPI templates. The 
names you give these new templates must contain a prefix with the original 
template name. To tell the collector/ analyzer to use this new template rather than 
the original template, specify the tag option on the schedule template command 
line.

New collector templates can also be created in this way, for example:

exspi_e2k -m 16 -t ADM-

In this case the new collector template is called "ADM-EXSPI-15min."
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Advanced Customization

Changing the Windows User Account name

A Windows user account, used for creating a mailbox, is referenced in the 
EXSPI MBOX Config application. To change the account name, edit the EXSPI 
Mbox Config application and change the user name setting. This application 
requires a user with Exchange administrative privileges.

Changing the Mailbox name

For all schedule templates in the template group EXSPI-60 Data Collection 
(Adv), add -x <mailbox_name> to the command which is executed under the 
schedule. For example: 

exspi_e2k -l-s -m 630,631,632 -x logtype=value -x 
mbox=MSXSPI

The default mailbox MSXSPI <hostname> can be changed by supplying the 
mailbox name to EXSPI MBOX Config:

Use the OVO Customized Startup to start EXSPI MBOX Config, and add 
-m <mailbox name prefix> [-ou <organizational unit>]
to the Application Parameter box.

NOTE Do not add the domain before the user name. The user must be in the domain 
where the Exchange Server is located, and cannot be a local user.
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Returning to original factory settings
To re-install all Exchange SPI templates, applications and message groups with 
original factory settings, run the following command:

/opt/OV/bin/OpC/opccfgupld -verbose -replace 
/var/opt/OV/share/tmp/OpC_appl/EXSPI/exspiset

CAUTION Any customization of the original templates will be overwritten.
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Introduction
Introduction
This chapter describes how to install and generate reports within Reporter from 
Exchange SPI data. It contains the following sections:

Installing Exchange SPI reports
Exchange SPI report template requirements
Table of data collection templates for reporting and graphing
Exchange SPI report list
Using Exchange SPI reports and graphs

Distributing the Quick Start data collection templates
Distributing Reporter Collection templates
Exchange SPI graphs
Deinstalling Exchange SPI Reporter templates
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Installing Exchange SPI Report Templates
 To install Reporter reports on the system where Reporter is installed:

1. Double-click EXSPI-Reporter.msi on the HP OpenView Operations for 
Unix Application CD-ROM. This opens the EXSPI-Reporter InstallShield 
Wizard.

2. Click Next on the welcoming dialog.

3. The next dialog confirms that EXSPI-Reporter is now installed, click Finish 
to exit the wizard.

4. Open Reporter to see the SPI for Exchange folder under Reports.

5. Open the SPI for Exchange group of reports, and see the groupings of 
Exchange reports. As you select each group, see in the details pane the 
individual reports available in that group.
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TEMPLATES TO DISTRIBUTE FOR EXCHANGE SPI REPORTS 

Exchange SPI reports display data collected from EXSPI templates distributed to 
Exchange servers. 

In the table that follows, the location is relative to the folders SPI for Exchange \ 
Exchange 5.5 AND Exchange 2000 and 2003. Some templates are specific to 
particular versions of Exchange, when this is the case the location is also specific 
to this version, all other reports are relevant to all versions of Exchange. 

The specific templates required for OVO to generate particular reports are as 
follows:

Report Name
(SUMMARY For 
All Systems)

Template Name Metric ID 
Logged

Location

Exchange 2003 
and 2000 System 
Information 
Summary 

Dc-Mailbox IS Sum. Data 
Dc-Public IS Sum.Data 
Dc-Exchange Info

 610-611, 614, 
620-621, 
623-624, 656

EXSPI Advanced 
\EXSPI Reporter 
Collection

Exchange 2003 
and 2000 Top 100 
Mailboxes
   

Dc-Mailbox Data  
630,632,633,634 
815

Exchange 2000 and 2003
\EXSPI Advanced 
\EXSPI Reporter 
Collection

Exchange SLA 
Message Delivery 
   

 End to End Message Ping 1002 EXSPI Advanced 
\EXSPI End to End 
Message Ping

Exchange System 
Information 
Summary

Dc-Private/Mailbox IS 
Sum. Data
Dc-Public IS Sum. Data
Dc-Exchange Info

610-611, 614,
620-621, 
623,624, 656

EXSPI Advanced 
\EXSPI Reporter 
Collection
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Exchange Top 100 
Mailboxes
 
 

Dc-Mailbox Data  630-632 Exchange 5.5
\EXSPI Advanced
\EXSPI Reporter 
Collection

Exchange Top 100 
Public Folders
    

Dc-Public Folder Data 640, 641 EXSPI Advanced 
\EXSPI Reporter 
Collection

Exchange 
Messaging Trends 
for all Servers 

Dc-MTA Message 
Volume

 530-535 EXSPI Quick Start 
\EXSPI Message Transfer 
Agent

Dc-IS Private MsgVol OR

Dc-IS Mailbox Msg Vol
Dc-IS Public Msg Vol

540-543
550-552

EXSPI Quick Start 
\EXSPI Information Store

Dc-IMS Message Volume 590-591  Exchange 5.5
\EXSPI Add-Ons 
\EXSPI Internet Mail 
Services

Dc-SMTP Message 
Volume
 

670-675 Exchange 2000 and 2003
\EXSPI Add-Ons 
\EXSPI SMTP 

Report Name
(SUMMARY For 
All Systems)

Template Name Metric ID 
Logged

Location

Report Name
(DETAIL-shows 
data grouped by 
single systems)

Template Name Metric ID 
Logged

Location

Exchange 2000 
Chat Trends 
 

EXSPI-6.0 Dc-Chat 
Service Clients and 
Channels.data

 837-838 Exchange 2000 and 2003
\EXSPI Add-Ons
\EXSPI Chat Service

Exchange 2000 
Conferencing 
Trends

EXSPI-6.0 
Dc-ConfTrends.data

 800, 810, 809, 
808

Exchange 2000 and 2003
\EXSPI Add-Ons 
\EXSPI Conferencing 
Service
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Exchange 2000 
MCU Trends
   

EXSPI-6.0 Dc-MCU 811-814 Exchange 2000 and 2003
\EXSPI Add-Ons 
\EXSPI Conferencing 
Service

Exchange 2000 
Instant Messaging 
Users growth

EXSPI-6.0 1d-Dc-Instant 
Messaging

 843 Exchange 2000 and 2003
\EXSPI Add-Ons 
\EXSPI Instant 
Messaging

Exchange 2000 
Instant Messaging 
Availability and 
Usage Trends 

EXSPI-6.0 1hr-Dc-Instant 
Messaging DC

 841, 845 Exchange 2000 and 2003
\EXSPI Add-Ons 
\EXSPI Instant 
Messaging

Exchange 2003 
and 2000 Inactive 
Mailboxes
       

EXSPI 6.0 Dc-Mailbox 
Data

 603,633,634, 
815

Exchange 2000 and 2003
\EXSPI Advanced 
\EXSPI Reporter 
Collection

Exchange 2003 
and 2000 Mailbox 
Details
    

EXSPI 6.0 Dc-Mailbox 
Data

 
630-632,634,815

Exchange 2000 and 2003
\EXSPI Advanced 
\EXSPI Reporter 
Collection

Exchange 2003 
and 2000 Mailbox 
Summary
    

EXSPI 6.0 Dc-Mailbox IS 
Sum. Data
EXSPI 6.0 Dc-Mailbox 
Data

610-613, 624, 
630-632, 815

Exchange 2000 and 2003
\EXSPI Advanced 
\EXSPI Reporter 
Collection

Exchange 2003 
and 2000 Mailbox 
Usage Trends
 

 EXSPI-6.0 Dc-Mailbox 
IS Sum. Data

 610-613 Exchange 2000 and 2003
\EXSPI Advanced 
\EXSPI Reporter 
Collection

Exchange 2003 
and 2000 Mailbox 
Store Stats

Dc-Mailbox IS Sum. Data 
& Dc-Mailbox Data

71, 614, 630,  
631, 632,  634, 
815

EXSPI Advanced\EXSPI 
Reporter Collection

Exchange 2003 
and 2000 Public 
Folder Store Stats

Dc-Public IS Sum. Data & 
Dc-Public Folder Data

73, 624, 640, 641 EXSPI Advanced\EXSPI 
Reporter Collection

Report Name
(DETAIL-shows 
data grouped by 
single systems)

Template Name Metric ID 
Logged

Location
7 - 128



Chapter 7: Integration with Reporter
Report Requirements
Exchange 2003 
and 2000 
Transaction Log 
Stats

Dc-Transaction Log 
Space Usage

7 EXSPI Add-Ons\EXSPI 
Transaction Log

Exchange User 
Connections
 

 Dc-User Connections
 

 520-521 EXSPI Quick Start
\EXSPI Services and 
Processes

Exchange Folder 
Summary

Dc-Public IS Sum. Data
Dc-Public Folder Data

620-624, 
640-641

 \EXSPI Advanced 
EXSPI Reporter 
Collection

Exchange Folder 
Usage Trends

Dc-Public IS Sum. Data  620-622  \EXSPI Advanced 
EXSPI Reporter 
Collection

Exchange IMS 
Messaging Trends
   

EXSPI-5.5 Dc-IMS 
Message Volume

 590-593 Exchange 5.5
\EXSPI Add-Ons 
\EXSPI Internet Mail 
Services

Exchange 
Mailbox Details

Dc-Mailbox Data 630-632  \EXSPI Advanced 
EXSPI Reporter 
Collection

Exchange 
Mailbox Summary
 

Dc-Private/Mailbox IS 
Sum. Data
Dc-Mailbox Data

 610-613, 
630-632

 \EXSPI Advanced 
EXSPI Reporter 
Collection

Exchange 
Mailbox Usage 
Trends

Dc-Private/Mailbox IS 
Sum. Data

610-612  \EXSPI Advanced 
EXSPI Reporter 
Collection

Exchange 
Messaging Trends 

Dc-MTA Message 
Volume

530-535 EXSPI Quick Start 
\EXSPI Message Transfer 
Agent

Dc-IS Private Msg Vol 
OR
Dc-IS Mailbox Msg Vol
Dc-IS Public Msg Vol

540-543
550-552

EXSPI Quick Start 
\EXSPI Information Store

Report Name
(DETAIL-shows 
data grouped by 
single systems)

Template Name Metric ID 
Logged

Location
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Dc-SMTP Message 
Volume

 670-675 Exchange 2000 and 2003
\EXSPI Quick Start 
\EXSPI General Data 
Collection

Exchange Top 
Destinations
   

Dc-TrackLog Data  662 EXSPI Advanced 
\EXSPI Reporter 
Collection

Exchange Top 
Recipients
    

Dc-TrackLog Data  661 EXSPI Advanced 
\EXSPI Reporter 
Collection

Exchange Top 
Senders 

Dc-TrackLog Data  660 EXSPI Advanced 
\EXSPI Reporter 
Collection

Exchange Top 
Sources

Dc-TrackLog Data  663 EXSPI Advanced 
\EXSPI Reporter 
Collection

Report Name
(DETAIL-shows 
data grouped by 
single systems)

Template Name Metric ID 
Logged

Location
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Data Collection for Graphing and Reporting
The Exchange SPI collects data for graphing and reporting through data 
collection templates. Exchange and Windows data is collected, summarized, and 
forwarded to the OVO data collecting agent. Reporter can be used to access the 
data source EXSPI_DATA and write reports using Seagate Crystal Reports.

Data is collected through the following data collection templates:

Table 1: Quick Start Data Collector Templates

Data Collector 
Name

Scheduled 
Times

 
Metric IDs Table

Dc-SMTP Message 
Volume

Hourly 670: SMTP Server.Messages Sent Total
671: SMTP Server.Messages Received Total
672: SMTP Server.Bytes Sent Total
673: SMTP Server.Bytes Received Total
674: SMTP Server.Message Bytes Sent Total
675: SMTP Server.Message Bytes Received Total
Note: These are running totals since the SMTP 
service started. The Exchange SPI calculates a 
delta value between readings and logs this value to 
show message volume.

EXSPI_MULTI   

Dc-SMTP Message 
Queues

Hourly 50: SMTP Server.Categorizer Queue Length
51: SMTP Server.Local Queue Length
52: SMTP Server.Local Retry Queue Length
53: SMTP Server.Messages Pending Routing
54: SMTP Server.Remote Queue Length
55: SMTP Server.Remote Retry Queue Length

EXSPI_MULTI

Measurement Data 
Collector

Hourly Writes the EXSPI_SINGLE values to the datastore 
each hour. 

EXSPI_SINGLE 

Create Coda Data 
Sources

Every 10 
mins

Creates database source EXSPIDATA with 
objects: EXSPI_SINGLE, EXSPI_MULTI, 
EXSPI_M0660, EXSPI_M0661, EXSPI_M0662, 
EXSPI_M0663, EXSPI_M1002, 
EXSPI_PFDETAIL, EXSPI_MBDETAIL, 
EXSPI_MBSUMMARY, EXSPI_PFSUMMARY, 
EXSPI_TRANLOG, EXSPI_SRS 

n/a
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Dc-IS Msg 
Delivery Time

Every 10 
minutes 
(0,10,20,30
, 40,50)

For hours: 
6-18 
Weekdays 
only

*This must 
be 
scheduled 
every 10 
mins 
beginning 
at the 0 
minute.

581: MSExchangeIS Mailbox.Average Local 
Delivery Time
582: MSExchangeIS Mailbox.Average 
Delivery Time
583: MSExchangeIS Public.Average Local 
Delivery Time
584: MSExchangeIS Public.Average 
Delivery Time
Note: The average value over all samples 
over all database instances in the hour is 
logged to EXSPI_SINGLE, while the 
average value over all samples is logged per 
instance to EXSPI_MULTI

EXSPI_MULTI 
(for each 
Database 
instance)

EXSPI_SINGLE 
(total over all 
Databases)

Dc-IS Private 
Mailbox Msg Vol

Hourly

For hours: 
6 - 18 
Weekdays 
only

540: MSExchangeIS Mailbox.Local 
deliveries
541: MSExchangeIS Mailbox.Messages 
Delivered
542: MSExchangeIS Mailbox.Messages Sent
543: MSExchangeIS Mailbox.Messages 
Submitted
544: MSExchangeIS Mailbox.Message 
Recipients Delivered
Note: These are running totals since the 
STORE service started. The Exchange SPI 
calculates a delta value between readings and 
logs this value to show message volume.

EXSPI_MULTI 
(for each 
Database 
instance)

EXSPI_SINGLE 
(total over all 
Databases)

Table 1: Quick Start Data Collector Templates

Data Collector 
Name

Scheduled 
Times

 
Metric IDs Table
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Dc-IS Public Msg 
Vol

Hourly

For hours: 
6-18 
Weekdays 
only

550: MSExchangeIS Public.Messages 
Delivered
551: MSExchangeIS Public.Messages Sent
552: MSExchangeIS Public.Messages 
Submitted
553: MSExchangeIS Public.Message 
Recipients Delivered
Note: These are running totals since the 
STORE service started. The Exchange SPI 
calculates a delta value between readings and 
logs this value to show message volume.

EXSPI_MULTI 
(for each 
Database 
instance)

EXSPI_SINGLE 
(total over all 
Databases)

Dc-MTA & IS 
Queue Lengths

Every 10 
minutes 
(0,10,20,30
,40,50)
For hours: 
6-18 
Weekdays 
only
*This must 
be 
scheduled 
every 10 
mins 
beginning 
at the 0 
minute.

570: MSExchangeMTA.Work Queue Length 
less MSExchangeMTA.Deferred Delivery 
Msgs
571: MSExchangeIS Mailbox.Send Queue 
Size
572: MSExchangeIS Mailbox.Receive Queue 
Size
573: MSExchangeIS Public.Send Queue Size
574: MSExchangeIS Public.Receive Queue 
Size
Note: The average value over all samples 
over all database instances in the hour is 
logged to EXSPI_SINGLE, while the 
average value over all samples is logged per 
instance to EXSPI_MULTI.

EXSPI_MULTI 
(for each 
Database 
instance)

EXSPI_SINGLE
(total over all 
Databases) 
 
EXSPI_SINGLE 
for MTA work 
Queue Length

Table 1: Quick Start Data Collector Templates

Data Collector 
Name

Scheduled 
Times

 
Metric IDs Table
7 - 133



Chapter 7: Integration with Reporter 
Data Collection for Graphing and Reporting
 Dc-MTA 
Message Volume

Hourly

For hours: 
6-18 
Weekdays 
only

530: MSExchangeMTA.Inbound Messages 
Total
531: MSExchangeMTA.Outbound Messages 
Total
532: MSExchangeMTA.Total Recipients 
Inbound
533: MSExchangeMTA.Total Recipients 
Outbound
534: MSExchangeMTA.Inbound Bytes Total
535: MSExchangeMTA.Outbound Bytes 
Total
Note: These are running totals since the MTA 
service started. The Exchange SPI calculates 
a delta value between readings and logs this 
value to show message volume.

 
EXSPI_SINGLE

Dc-User 
Connections

Hourly 
For hours: 
7-18 
Weekdays 
only

520: MSExchangeIS.Active User Count
521: MSExchangeIS.User Count
 

 
EXSPI_SINGLE

Table 1: Quick Start Data Collector Templates

Data Collector 
Name

Scheduled 
Times

 
Metric IDs Table
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Table 2: Add-Ons Data Collector Templates

Data Collector 
Name

Scheduled 
Times

 Metric IDs Table

Dc-Chat Data 
Collection

30 minutes 
Weekdays only

837: Microsoft Exchange Chat Service.Clients
838: Microsoft Exchange Chat Service.Channels

EXSPI_MULTI

Dc-ConfTrends 30 minutes

For hours: 7-18
Weekdays only

800: MSExchangeCONF.Active Conferences
808: MSExchangeDcsMgr.Local Conferences
809: MSExchangeDcsMgr.Remote Conferences
810: MSExchangeDcsMgr.Active MCUs

 EXSPI_MULTI 

Dc-MCU 30 minutes
For hours: 7-18
Weekdays only

811: MSExchangeT120.Data Messages Received
812: MSExchangeT120.Data Messages Sent
813: MSExchangeT120.KBytes Received
814: MSExchangeT120.KBytes Sent
Note: These are running totals since the 
Conferencing service started. The Exchange SPI 
calculates a delta value between readings and logs 
this value to show message volume.

EXSPI_MULTI 

Dc-Instant 
Messaging 
Enabled Users

Hourly 843: Number IM enabled users on Server EXSPI_MULTI

Dc-Instant 
Messaging

Hourly 841: MSExchangeIM Virtual Servers.Current 
Users Online
842: MSExchangeIM Virtual Servers.Current 
Subscriptions
845: MSExchangeIM.Failed Requests/sec
846: MSExchangeIM.Rejected Requests/sec

 EXSPI_MULTI

Dc-SRS Data 
Space Usage

Hourly 112, 113, 114 EXSPI_SRS

Dc-Transaction 
Log Space Usage

Hourly 7: Log File Size
    Free Space on Volume
    Total Size of Volume
    Percentage Free on Volume

EXSPI_TRANSLOG
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Table 3: Advanced Data Collector Templates

Data 
Collector 
Name

Scheduled 
Times

 Metric IDs Table

Dc-Exchange 
Info

 Daily 655: Server 
656: Site
657: Organization

EXSPI_MULTI  

Dc-Mailbox 
Data

Weekly 630: Mailbox size (MB)
631: Number of messages
632: Storage Limit
634: Last logon date/time
815: Database Instance

EXSPI_MULTI And 
EXSPI_DETAILS

Dc-Mailbox IS 
Sum. Data

Daily 71: Physical DB size (EDB)
      STM Size
      EDB Free
      STM Free
      EDB Total
      STM Total
      Logical Size
      Number of Mailboxes
      Number of Messages
614: MSExchangeIS Mailbox.Single Instance 
Ratio

EXSPI_MBSUMMARY

EXSPI_MULTI

Dc-Public 
Folder Data

Weekly 73: Folder Size
624: Number of Messages

EXSPI_MULTI 

Dc-Public IS 
Sum. Data

Daily 73: Physical DB size (EDB)
      STM Size
      STM Free
      EDB Total
      STM Total
      Logical Size
      Number of Folders
      Number of Messages
624: MSExchangeIS Public.Single Instance Ratio
640: Folder Size
641: Number of messages

EXSPI_SINGLE 

EXSPI_MULTI
EXSPI_PFDETAIL
EXSPI_PFDETAIL
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Dc-TrackLog 
Data

Weekly 660: Email Senders
661: Email Recipients
662: Email Destinations
663: Email Sources

EXSPI_M0660
EXSPI_M0661
EXSPI_M0662
EXSPI_M0663

End to End 15 minutes 1002: SLA values of:
Met SLA
Almost Met SLA
This schedule not only executes the sending of 
messages it also logs the data to the data store.

EXSPI_M1002 

Data 
Collector 
Name

Scheduled 
Times

 Metric IDs Table
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Reports for ALL Exchange versions
These reports gather data from all OVO managed Exchange servers, regardless 
of version.

DETAIL REPORTS FOR ALL EXCHANGE VERSIONS

Exchange Folder Usage Trends: Contains graphs showing trends in 
database size, number of messages and average size of public folders. 
The trends are shown for the time period selected when the report is 
generated.

Exchange Messaging Trends: Provides trend graphs showing 
messaging volume for the Message Transfer Agent, Information Store 
and SMTP server message volume.

Exchange Mailbox Usage Trends: Contains graphs showing trends in 
database size, number of messages, and average size of mailboxes. The 
trends are shown for the time period selected when the report is 
generated.

Exchange Top Destinations: Identifies the top Email destinations 
(local, other Exchange sites, internet, gateway) for Email being sent by 
an Exchange server.

Exchange Top Recipients: Identifies the top recipients of Email for an 
Exchange server.

Exchange Top Senders: Identifies the top senders of Email for an 
Exchange server. Only Email sent by users that have Exchange 
mailboxes is counted. Email sent by clients such as Netscape and UNIX 
that do not have a corresponding Exchange mailbox are not counted. 

Exchange Top Sources: Identifies the top Email sources (local, other 
Exchange sites, internet, gateway) for Email being received by an 
Exchange server.
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Exchange User Connections: Provides a trend graph showing open 
and active user connections for the selected Exchange server.

SUMMARY REPORTS FOR ALL EXCHANGE VERSIONS

Exchange System Information Summary: Contains summary 
information about the OS and Exchange versions, mailboxes and public 
folders.

Exchange Messaging Trends for All Servers: Provides trend graphs 
showing messaging volume for the Message Transfer Agent, the 
Information Store, the Internet Mail Service across all Exchange 
servers, and the SMTP server messaging volume.

Exchange Message Delivery SLA (Service Level Agreement): 
Provides a trend graph showing how message delivery, messages read, 
and directory read service levels are being met across all monitored 
connections.
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Reports for Exchange 2000 and 2003 

DETAIL REPORTS FOR EXCHANGE 2000/2003 SERVERS

Detail reports provide information by system. One report is generated with a 
section for each system. The content of each report is as follows:

Exchange 2000 Chat Trends: Provides averaged information on the 
number of client chat connections and channels for hours of the day 
over the time period indicated.

Exchange 2000 Conferencing Trends: Provides averaged information 
on the number of conferences and active MCUs for hours of the day 
over the time period indicated.

Exchange 2003 and 2000 Folder Summary: Provides summary 
information about the public folders on the server.

Exchange 2003 and 2000 Folder Usage Trends: Contains graphs 
showing trends in database size, number of messages and average size 
of public folders. The trends are shown for the time period selected 
when the report is generated.

Exchange 2003 and 2000 Inactive Folders: This report lists all the 
folders on the server that have not been accessed. The report also lists 
folders that have not been accessed in 20, 40 and 60 or more days.

Exchange 2003 and 2000 Inactive Mailboxes: This report lists all the 
mailboxes on the server that have not been accessed. The report also 
lists mailboxes that have not been accessed in 20, 40 and 60 or more 
days.

Exchange 2000 Instant Messaging Availability Trends: Shows 
instant messaging usage trends.

Exchange 2000 Instant Messaging Users Growth: Shows the number 
of users that are Instant Messaging enabled over the time period 
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indicated. 

Exchange 2003 and 2000 Mailbox Details: Provides detailed 
information about the mailboxes on the server including summary 
totals, size distribution, and top mail users.

Exchange 2003 and 2000 Mailbox Store Stats: Provides database 
volume statistics for Mailbox Store database files, for each managed 
Exchange Server. The report gives a snapshot of the volume usage, as 
of the most recent data collection.

Exchange 2003 and 2000 Mailbox Summary: Provides summary 
information about the mailboxes on the server including summary 
totals, size distribution, and top mail users.

Exchange 2003 and 2000 Mailbox Usage Trends: Contains graphs 
showing trends in database size, number of messages, and average size 
of mailboxes. The trends are associated per storage group and are 
shown for the time period selected when the report is generated.

Exchange 2000 MCU Trends: Provides averaged information on the 
number of conferences and active MCU's for hours of the day over the 
time period indicated.

Exchange 2003 and 2000 Public Folder Store Stats: Provides 
database volume statistics for Public Folder Store database files, for 
each managed Exchange Server. The report gives a snapshot of the 
volume usage, as of the most recent data collection. 

Exchange 2003 and 2000 Transaction Log Stats: Provides 
information concerning usage and availability of storage, by and for the 
Exchange Transaction log.
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SUMMARY REPORTS FOR EXCHANGE 2000/2003 SERVERS

Summary reports show data for ALL Exchange 2000 and 2003 servers. The 
content of each report is as follows

Exchange 2003 and 2000 System Information Summary: Contains 
summary information about the OS and Exchange versions, mailboxes 
and public folders.

Exchange 2003 and 2000 Top 100 Mailboxes: Lists the top 100 
mailboxes by disk space usage across all mailbox databases.

Exchange Top 100 Public Folders: Lists the top 100 public folders by 
disk space usage.
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Reports for Exchange 5.5 only

DETAIL REPORTS FOR EXCHANGE 5.5 SERVERS

Detail reports provide information by system. One report is generated with a 
section for each system. The content of each report is as follows:

Exchange 5.5 Folder Summary: Provides summary information about 
the public folders on the server.

Exchange 5.5 Mailbox Details: Provides detailed information about 
the mailboxes on the server. 

Exchange 5.5 Mailbox Summary: Provides summary information 
about the mailboxes on the server including summary totals, size 
distribution, and top mail users.

Exchange 5.5 IMS Messaging Trends: Provides trend graphs showing 
messaging volume for the Internet Mail Service.

SUMMARY REPORTS FOR EXCHANGE 5.5 SERVERS

Summary reports show data for ALL Exchange 5.5 servers. The content of each 
report is as follows:

Exchange Top 100 Mailboxes: Lists the top 100 mailboxes by disk 
space usage.

Exchange Top 100 Public Folders: Lists the top 100 public folders by 
disk space usage.
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Using Exchange SPI Reports and Graphs
Exchange SPI report and graph generation require that you complete the following:

• Distribute the Quick Start template group for data collection templates.

• Configure and distribute Exchange SPI reporter collection templates.

NOTE: Time Interval for Exchange SPI Reports or Graphs

Exchange SPI reports and graphs will not be available until data has been gathered 
to the management server from the managed nodes. This occurs each night, so at 
least one day of activity is needed for the reports to populate. Where a report or 
graph type requires data from a Sat/Sun collection, those reports/graphs will require 
a weekend to pass.

Distributing the Quick Start Template Group
In order to collect data for reports and graphs the General Data Collection templates 
in the Quick Start template group need to be distributed.

For the procedure to distribute templates, see Task 8: Assign/Distribute Quick Start 
Templates chapter 3 page 63.
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Configure/Distribute Reporter Collection 
Templates 

For any Exchange server system on which you would like to receive reports, you 
need to distribute Exchange SPI templates from the EXSPI Advanced > EXSPI 
Reporter Collection group.

To configure the Reporter Collection templates two steps are required:

1. Complete the Advanced Configuration procedure.

2. Distribute Reporter Collection templates.

1. COMPLETE THE ADVANCED CONFIGURATION 
PROCEDURE

For detailed steps, see Advanced Configuration chapter 3 page 65.

2. DISTRIBUTE REPORTER COLLECTION TEMPLATES

The reporter collection templates need to be distributed to any managed nodes 
where data is to be collected for reporting and graphing. For the procedure to 
distribute templates, see Task 8: Assign/Distribute Quick Start Templates chapter 
3 page 63.
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Deinstalling Exchange SPI Reporter

Remove the Exchange SPI reporter in one of the following ways:

1. Using the Windows Start menu.

2. Using the EXSPI-Reporter InstallShield wizard.

Using the Windows Start menu:
1. Select Start > Settings > Control Panel > Add/Remove Programs.

2. Select EXSPI-Reporter.

3. Click Remove. 

Using the EXSPI-Reporter InstallShield wizard.
1. Double-click EXSPI-Reporter.msi. This opens the EXSPI-Reporter 

InstallShield Wizard. Click Next on the Welcome screen.

2. Confirm the next screen by clicking Remove.

3. The InstallShield Wizard has deinstalled EXSPI-Reporter. Click Finish.
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Exchange SPI Graphs

Exchange SPI comes with a set of preconfigured PerfView graphs. These graphs 
require that OpenView PerfAgent (aka MW Agent) be running on the managed 
node, see Exchange SPI Graphs chapter 7 page 147.

Open the Exchange 5.5, or 2000/2003 Graphs window in the version specific 
Application Group

TO INVOKE GRAPHS:

1. Select relevant Exchange managed nodes in the VPO Node Bank.

2. Drag these nodes and drop them on the desired graph.

.
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Exchange SPI graphs are the same for each Exchange version, except the 
Transaction Log file size graph is only for Exchange 5.5.

INFORMATION STORE

Delivery: This graph shows hourly metrics for the average delivery times of 
messages to Exchange Server private and public mailboxes.

Mailbox Usage: This graph shows Exchange Server Mailbox usage.

Mailbox Volume: This graph shows Exchange Server Mailbox volume.

Public Folder Usage: This graph shows Exchange Server Public Folder usage.

Public Folder Volume: This graph shows Exchange Server Public Folder 
volume.

Users: This graph shows information store user count metrics for the current 
day.
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MESSAGING

Internet Mail Queue: This graph shows the Exchange Server Internet Mail 
Service queue count. 

Internet Mail Volume: This graph shows Exchange Server Internet Mail 
Connector volume. 

MTA Volume: This graph shows Exchange Server Message Transfer Agent 
volume. 

Newsfeed Volume: This graph shows Exchange Server newsfeed volume. 

Queues: This graph show Exchange Server queue lengths. 
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SYSTEM INFORMATION

System Information for the following areas of performance are made available in 
graph format:

NT CPU

NT Disk

NT History

NT Memory

NT Network

TRANSACTION LOG DISK SPACE (EXCHANGE 5.5 ONLY)

This graph shows Transaction Log Disk Space usage on Exchange 5.5 servers.
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Generating Graphs from an Exchange SPI DSI 
Logfile
PerfView graphs require an OVO agent to be running on the targeted 
management server. You can generate PerfView graphs from the Exchange 
version specific Exchange SPI Application Group window, and then opening the 
Exchange 5.5, or 2000/2003 Graphs window. Graphs display the metric data 
collected by the Exchange SPI data collector.

In addition, data from any Exchange SPI server can be graphed using PerfView 
and data from Exchange SPI MeasureWare DSI logfiles. 

Simple instructions for generating the graph follow. Additional information on 
using PerfView can be obtained from the PerfView User Guide.

1. Open a terminal window and log on.

2. In the terminal window, to verify that the DISPLAY environment variable is 
set to your terminal window, enter:

echo $DISPLAY

If the DISPLAY environment variable is not set correctly, set it to your 
terminal window.

3. To start PerfView, type:

pv

The main PerfView window is displayed.

NOTE Since values are logged hourly to MeasureWare, use the PerfView Graph: 
Settings->Points Every to set the time setting to 1h or 3h.
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4. Select Data Sources>Manage.

5. In the PerfView Systems window highlight the desired system from the list 
and click Open.

The Data Sources window is displayed listing all known source files. If the 
desired data source is not listed, press Select and enter the data source name.

6. Select the desired source file from the list and click Open.

Perfview connects to the data source and displays it in the main window.

7. Select Graphs>Create New Graph.

8. In the Select Metrics window highlight the data source file.

A list of metrics is displayed to use for graphing.

9. Highlight the desired metrics from the list to use for graphing.

The selected metrics are displayed in the Metrics to Be Graphed portion of 
the Select Metrics window.

10. Click OK when finished selecting metrics.

11. Click Draw to generate the graph.

12. You can use the Settings menu on the PerfView Graph window to change 
settings for the graph, the Show menu to drill down to examine points on 
the graph, and the File menu to save, print, or export the graph. You can 
also correlate operating system metrics with Exchange SPI metrics.
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Introduction
Introduction
This chapter offers troubleshooting suggestions for Exchange SPI. It includes the 
following sections:

Self-Healing Information for enhanced troubleshooting
Verifying Software Installation on the Management Server
The Exchange SPI Error Log
Turning on/ Disabling Tracing
Common Errors
Verifying the MSXSPI account has the right privileges 
Verifying MeasureWare Integration
Installing Old DSI Log Files
Advanced Configuration Template Failures
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Self-Healing Information for enhanced 
troubleshooting
The Exchange SPI now includes a Self-Healing Info application that gathers 
data useful for troubleshooting issues. The application can be launched on the 
managed node to gather specific error messages, and other relevant data that can 
help you diagnose problems. 

Even though the Self-Healing Info application can work independently, it can 
also be integrated with HP OpenView Self-Healing Services, available at no cost 
with your support contract. Self-Healing Services speeds up the problem 
resolution process by allowing you to easily open an incident and send data 
straight to a secure HP support site. For more information, see HP Openview’s 
Software Support Oline Web site at:

http://support.openview.hp.com/self_healing.jsp

NOTE If Self-Healing Services is already installed, you will have to re-start it after 
installing your SPI. Whenever possible, install the SPI before installing 
Self-Healing Services. An upgrade to SPIs on a managed node already running 
Self-Healing Services requires a re-start of Self-Healing Services.

After you install the Self-Healing Services client on the managed node, you no 
longer need to launch the Self-Healing Info application. Self-Healing Services 
automatically gathers error-related and system data when you submit an 
incident.

USING THE SELF-HEALING INFO APPLICATION

1. Turn on tracing, see Turning on Tracing chapter 8  page 160.

2. Reproduce your problem.

3. Open the Node Bank window and locate the node on which you want to run 
the Self-Healing Info application.

4. Open the Application Bank window and double-click EXSPI.Admin.
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5. Drag and drop the node onto the Self-Healing Info application.

6. In the message that appears, note where the compressed file will be stored.

7. Send the file to the above-mentioned HP support site for diagnosis.
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Verifying Exchange SPI Installation on the 
Management Server

NOTE: This utility is not available for Sun Solaris.
1. To check the integrity of Exchange SPI files on the OVO management 

server, run the following command: 

/usr/sbin/swverify SPI-EXCHANGE-OVO

This command produces output similar to the following:

 (non-interactive) (jobid=ovruxr13-0161)
       * Session started for user "root@ovruxr13".
       * Beginning Selection
       * Target connection succeeded for "ovruxr13:/".
       * Software selections:
+ DSI2DDF.DSI2DDF,l=/,r=A.02.00.00,a=HP/SunOS,v=HP
SPI-EXCHANGE-OVO.EXSPI,l=/,r=A.08.20.6,a=HP-UX_B.11.00_32
/HP-UX_B.11.00_64,v=HP
+SPI-SHS-OVO.SPI-SHS-AIX,l=/,r=A.01.00.00,a=HP_UX_10/11,v
=HP
+SPI-SHS-OVO.SPI-SHS-CORE,l=/,r=A.01.00.00,a=HP_UX_10/11,
v=HP
+SPI-SHS-OVO.SPI-SHS-HPUX,l=/,r=A.01.00.00,a=HP_UX_10/11,
v=HP
+SPI-SHS-OVO.SPI-SHS-LXx86,l=/,r=A.01.00.00,a=HP_UX_10/11
,v=HP
+SPI-SHS-OVO.SPI-SHS-OSF,l=/,r=A.01.00.00,a=HP_UX_10/11,v
=HP
+SPI-SHS-OVO.SPI-SHS-SOL,l=/,r=A.01.00.00,a=HP_UX_10/11,v
=HP
+SPI-SHS-OVO.SPI-SHS-UX64,l=/,r=A.01.00.00,a=HP_UX_10/11,
v=HP
+SPI-SHS-OVO.SPI-SHS-WIN,l=/,r=A.01.00.00,a=HP_UX_10/11,v
=HP
+SPI-SVCDISC-OVO.SPI-SVCDISC-AGT-AIX,l=/,r=A.02.00,a=HP_U
X_11,v=HP,fr=A.02.00,fa=HP_UX_11
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+SPI-SVCDISC-OVO.SPI-SVCDISC-AGT-HP,l=/,r=A.02.00,a=HP_UX
_11,v=HP,fr=A.02.00,fa=HP_UX_11
+SPI-SVCDISC-OVO.SPI-SVCDISC-AGT-LNX,l=/,r=A.02.00,a=HP_U
X_11,v=HP,fr=A.02.00,fa=HP_UX_11
+SPI-SVCDISC-OVO.SPI-SVCDISC-AGT-SOL,l=/,r=A.02.00,a=HP_U
X_11,v=HP,fr=A.02.00,fa=HP_UX_11
+SPI-SVCDISC-OVO.SPI-SVCDISC-AGT-TRU64,l=/,r=A.02.00,a=HP
_UX_11,v=HP,fr=A.02.00,fa=HP_UX_11
+SPI-SVCDISC-OVO.SPI-SVCDISC-AGT-WIN,l=/,r=A.02.00,a=HP_U
X_11,v=HP,fr=A.02.00,fa=HP_UX_11
+SPI-SVCDISC-OVO.SPI-SVCDISC-SRV-HP,l=/,r=A.02.00,a=HP_UX
_11,v=HP,fr=A.02.00,fa=HP_UX_11
       * A "+" indicates an automatic selection due to 
dependency or the automatic selection of a patch or 
reference bundle.
       * Selection succeeded.
       * Beginning Analysis
       * Session selections have been saved in the file:
        /root/users/afshinsu/.sw/sessions/swverify.last
NOTE: More information may be found in the agent logfile 
using the command 
swjob -a log ovruxr13-0161 @ ovruxr13:/
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The Exchange SPI Error Log
OVO7 and OVO8/DCE errors are forwarded to the browser and logged to:

\usr\OV\exspi\log\exspierror

OVO8/HTTPS errors are logged to:

<Installation_Directory>\Data\exspi\log\exspierror 

For example:

04/01/02 08:43:57 ERROR exspi(488) [colamain.cpp:333]: 
EXSPI-60-40:
Exchange Server Software not installed on this system 
(Check: SOFTWARE\Microsoft\Exchange\Setup). Unable to 
perform collection!
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Turning on Tracing
If a problem occurs and you are asked to turn on tracing by the EX-SPI support 
team, use the Enable EXSPI Tracing application for the relevant Exchange 
version. 

1. Select all the Exchange managed nodes you wish to configure in the OVO 
Node Bank.

2. Drag and drop these nodes on the Enable EXSPI Tracing application 
located in the EXSPI Admin application group under the appropriate 
version.

3. Verify whether there are any errors in the Output of Application window.

Output of Application window
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DISABLING TRACING

For disabling the tracing, use Disable EXSPI Tracing.

NOTE The trace file will grow very large. It is advisable to leave tracing enabled only 
long enough to recreate the problem, or in order to comply with HP support 
instructions.
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Common Errors
1. When re-installing or upgrading Exchange Server, Exchange Setup program 

shows errors.

Symptom: Exchange Server re-install or upgrade (e.g., new Service Pack), 
the Exchange Setup generates error messages about DLLs that can't be 
overwritten.

Solution: Stop OVO (opcagt -stop) and MeasureWare (mwacmd 
stop), then retry the operation.

2. Schedule template fails with message:
EXSPI xxxxx Metric Collection failed.

Symptom: The scheduled command failed with an exit code other than 0.

Solution: This error sometimes occur if the system is rebooted just before 
the collector/analyzer program was executed. 

However, if this is not the case do the following: To find out more 
information about the failure, modify the failing schedule template, check 
the Send Output of Action check box and re-distribute templates again.

The browser message should now contain an annotation with more 
information about the failure. Also, check the exspierror for more 
information.

3. Error when distributing Exchange 5.5 ConfigFile templates to Windows 
NT4 managed nodes.

Symptom: During ConfigFile template distribution to Windows NT nodes, 
the following system error message box appears and the action fails:

      OvCfgFile.exe - Entry Point Not Found. The procedure 
entry point __lc_collate_cp could not be located in the 
dynamic link library MSVCRT.dll.
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Solution: The Windows managed node does not have the correct version of 
the Microsoft C Runtime library MSVCRT.dll installed on the managed 
node (MSVCRT.dll is located in the system32 directory). Upgrade your 
system by downloading and installing a newer version of MSVCRT.dll as 
described in Microsoft Knowledge Base article Q259403 at:     
www.support.microsoft.com/default.aspx?scid=kb;EN-US;q259403 
Updating MSVCRT.dll may require a reboot. Afterwards, restart the failed 
ConfigFile-template distribution.
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Verifying MSXSPI account has right 
privileges
In order to verify that you have created the MSXSPI account with the right 
amount of privileges to run advanced metrics such as 5, 841, or 630, do the 
following:

1. Log into your Exchange 2000 or 2003 server as MSXSPI user (in the 
correct NT domain).

2. Open a DOS command prompt window.

3. cd to the directory where exspi collector is located (for OVO7 and 
OVO8/DCE typically in c:\usr\OV\bin\OpC\monitor, for 
OVO8/HTTPS <InstallDir>\data\bin\instrumentation).

4. Run the following series of commands:

exspi_e2k.exe  -m 5   -p

exspi_e2k.exe  -m 841   -p

exspi_e2k.exe  -m 630   -p

5. These will print the results to the screen.

6. If these executed properly and the correct results printed on the screen, your 
MSXSPI account has the right permissions.
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Verifying MeasureWare Integration
To verify MeasureWare integration check the following:

1. Is the MeasureWare Agent installed on the Exchange server managed node?

2. Is the MeasureWare agent up and running (mwacmd status or 
MeasureWare Agent application in RPM Tools Windows group)? There 
should be TWO rep_server programs running. If not, re-start 
MeasureWare Agent.

3. Verify MeasureWare Agent configuration.

Verify that perflbd.mwc (e.g., in \rpmtools\data) contains 
EXSPI_DATA data source.

If not, re-run MW setup: First run, Disable Data Logging, wait for 
MW to re-start, then run Enable Data Logging.

Verify that DSI logfiles were created in 
\usr\exspi\dsi\log\exspi_log.EXSPI_*

Check the timestamps of those files; they are updated when the data 
collectors run.

4. Verify exspi_e2k.exe or exspi_e55.exe data forwarding:

For OVO7 and OVO8/DCE the collector/analyzer exspi_e2k.exe 
or exspi_e55.exe specified in the schedule templates writes 
MeasureWare data to \usr\OV\exspi\dsi\*.dat only if the 
keyword MW ON is present in the \usr\OV\exspi\defaults file 
(Note: the defaults file has no file extension.). Check the defaults file 
for the above keyword. If not present, run EXSPI Add DataSource.

For OVO8/HTTPS the collector/analyzer exspi_e2k.exe or 
exspi_e55.exe specified in the schedule templates writes 
MeasureWare data to <InstallDir>data\exspi\dsi\*.dat only 
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if the keyword MW ON is present in the 
<InstallDir>data\exspi\defaults file. (Note: the defaults file 
has no file extension.). Check the defaults file for the above keyword. If 
not present, run EXSPI Add DataSource.

Check whether *.dat files are present in \usr\OV\exspi\dsi. (for 
OVO7 and OVO8/DCE), or <InstallDir>data\exspi\dsi (for 
OVO8/HTTPS).

Check timestamps of *.dat files.

Advanced Configuration Template Failures
Symptom: The following data collectors fail and a critical message is 
shown in the OVO browser:

EXSPI-60/55 Dc-Private IS Sum. Data

EXSPI-60/55 Dc-Public IS Sum. Data

EXSPI-60/55 Dc-Mailbox Data

EXSPI-60/55 Dc-Public Folder Data

Solution: These collectors access Exchange directly and require MSXSPI 
user and MSXSPI<hostname> mailbox.

Verify MSXSPI user, MSXSPI<hostname> mailbox, MSXSPI rights in 
Exchange and MeasureWare:

1. Verify MSXSPI user setup.

Use Windows User Manager to verify MSXSPI account. The user must 
exist in the same domain as the Exchange Server is part of. Note: there 
must be no local MSXSPI user.

For Exchange 5.5, the MSXSPI user must be part of Domain Admin 
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group.

2. Verify MSXSPI rights in Exchange.

The MSXSPI user must have "Receive As" and "Send As" Exchange 
Admin permissions. See Creating a Service Account with Proper Access 
Permissions chapter 2  page 22.

3. Verify MSXSPI<hostname> mailbox.

Use Exchange Admin to verify that a MSXSPI<host_name> mailbox exists 
and click on Recipients. In the right pane, a MSXSPI<host_name> user 
must show up for each server which belongs to the site.

4. Verify MeasureWare Agent integration as described in Verifying 
MeasureWare Integration chapter 8  page 165.
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Introduction
This chapter lists the Exchange SPI file names, along with their descriptions, 
owners, groups, and permissions. Exchange SPI files are grouped as follows:

Management server files
Management server/managed node files
Managed node files
Logging and trace files
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TEMPLATES FOR OPCCFGUPLD (OVO UPLOAD FACILITY)

All files listed in this table can be found on the management server in the 
following directories (the location of these files varies by platform):

/var/opt/OV/share/tmp/OpC_appl/EXSPI/exspiset/C/

Table 1: Management Server Files
File Description

exspiset.idx OVO upload control file. This 
file defines what is being 
uploaded into OVO: message 
groups, monitor templates, logfile 
templates, applications and 
template groups.

TEMPLATES/LOGFILE
/logfile.dat

Definition file for logfile 
encapsulation. 

TEMPLATES/MONITOR
/monitor.dat

Definition file for OVO 
templates: collector/analyzer 
program, external monitor for 
each metric and file system 
monitor. Contains all details for 
monitoring all metrics.

TEMPLATES/SCHEDULE
/schedule.dat

Definition file for Exchange SPI 
schedule templates.

TEMPLATES/TEMPLGROUP
/templgrp.dat

Definition file for OVO template 
group structure.

TEMPLATES/MSGGROUPS
/msggrps.dat

Definition file for OVO message 
group structure.

TEMPLATES/INTERFACE
/msgi.dat

Definition file for Exchange SPI 
specific error message.
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MISCELLANEOUS MANAGEMENT SERVER FILES

Table 2: Miscellaneous Other Management Server Files

File Description

/etc/opt/OV/share/conf
/OpC/mgmt_sv/
reports/exspi_lc.sql

Report that lists all nodes that have 
Exchange SPI templates assigned (for 
license check).

/opt/OV/EXSPI/bin/exspipv Script to run PerfView as metric operator 
actions and bring up graphs.

/opt/OV/EXSPI/bin/exspircfg                         Script for EXSPI Node Config.

/opt/OV/EXSPI/bin/EXSPI_DiscConfig.sh            Script for setting Exchange SPI related 
variables. 

/opt/OV/EXSPI/bin/exspipngcfg_e55.sh        Script for End-to-End Ping config for 
Exchange 5.5

/opt/OV/EXSPI/bin/exspipngcfg_e2k.sh        Script for End-to-End Ping config for 
Exchange 2000 and 2003
A - 172



Appendix A:
Management Server/Managed Node Files
Management Server/Managed Node Files
When you run swinstall, the following monitor and command files are installed 
on the Management Server. They are also installed on managed nodes when you 
distribute monitors, commands and actions from the Management Server to the 
managed nodes.

MONITOR FILES

On Management Server:

/var/opt/OV/share/databases/OpC/mgd_node/customer/ms/
intel/nt/monitor/  (for DCE)

and

/var/opt/OV/share/databases/OpC/mgd_node/customer/ms/x86/ 
winnt/monitor/ (for HTTPS)

On Managed Node:

\usr\OV\bin\OpC\monitor (for DCE)

and

<OVO-DATADIR>\bin\instrumentation (for HTTPS)

Table 3: Monitor Files 

 File  Description

 exspi_e2k.exe  Exchange 2000/2003 SPI Collector/Analyzer 
program.

 exspi_e55.exe  Exchange 5.5 SPI Collector/Analyzer program.

msexchange.apm.xml Template list for cluster fail-over

 OVAMTLog2k.dll  Tracking.Log access library for Exchange 
2000/2003
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NOTE: All files in Table 3: Monitor Files, are in compressed ".Z" format to improve 
distribution performance.

COMMAND FILES 

Command files are located in the following directories:

Management Server:

/var/opt/OV/share/databases/OpC/mgd_node/customer/ms/
intel/nt/cmds  (for DCE)

and

/var/opt/OV/share/databases/OpC/mgd_node/customer/ms/

x86/winnt/cmds (for HTTPS)

Managed Node:

\usr\OV\bin\OpC\intel\cmds (for DCE)

and

<OVO-DATADIR>\bin\instrumentation  (for HTTPS)

All files in this table are in compressed ".Z" format to improve 
distribution performance.

 OVAMTLog55.dll  Tracking.Log access library for Exchange 5.5

 OVAMDa.dll  LDAP access library

 hpudm.txt  Internal data file

 File  Description
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Table 4: Command Files

File Description

exspitra.vbs Turns EXSPI Tracing on/off
-v ON
-v OFF

exspimwd.vbs Turns data forwarding to MeasureWare on/off 
(collector/analyzer will only forward data to 
MeasureWare if set to on:
-v ON
-v OFF

exspienc.exe For configuring managed node; part of the advanced 
configuration.

exspi_e2k_cfg.vbs For configuring an Exchange 2000 or 2003 server 
mailbox.

exspi_e55_cfg.exe For configuring an Exchange 5.5 server mailbox.

exspiDDF.bat For turning on data collection.

EXSPI_CODA_m0660.spec/ 
EXSPI_MW_m0660.spec
EXSPI_CODA_m0661.spec/ 
EXSPI_MW_m0661.spec
EXSPI_CODA_m0662.spec/ 
EXSPI_MW_m0662.spec
EXSPI_CODA_m0663.spec/ 
EXSPI_MW_m0663.spec
EXSPI_CODA_m1002.spec/ 
EXSPI_MW_m1002.spec
EXSPI_CODA_multi.spec/ 
EXSPI_MW_multi.spec
EXSPI_CODA_single.spec/ 
EXSPI_MW_single.spec
EXSPI_CODA_details.spec/ 
EXSPI_MW_details.spec
EXSPI_CODA_pfdetail.spec/
EXSPI_MW_pfdetail.spec

Data log specification
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exspi_e2k_clust_config.js  Generates xml output, which can be used for editing the 
apminfo.xml file

exspi_dbmount.vbs 
(NOTE: This file is also present 
under monitor and actions 
directories) -

Checks and mounts dismounted information store(s)

File Description
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Windows Managed Node Files

MONITOR TEMPLATES

When templates are distributed from the management server to the Windows 
managed nodes, the monitor templates are encrypted and stored in the following 
directory:

%OVAgentDir%\conf\OpC\<hostname>\
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Logging and Trace Files
Logging and trace files are located in the following directory on the managed 
node:

%OVAgentDir%\exspi\log

Table 5: Logging and Trace Files
File Description

trace When TRACE ON is set in 
%OVAgentDir%\exspi\defaults, tracing and debug 
information is written to  %OVAgentDir%\exspi\log. This 
file can get very large.

exspierror Error information when the Exchange SPI collector/analyzer 
encounters an error condition. Messages written to this file are 
also sent to the OVO message browser.
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Appendix B:  
This appendix covers the Exchange SPI program components and contains the 
following topics:

Component Interaction
Table of Exchange 2000 and 2003 Templates
Table of Exchange 5.5 Templates 
B - 180



Appendix B:
Component Interaction
Component Interaction
The Exchange SPI consists of the following logical components: 

Template Groups with schedule and monitor templates: Monitor templates 
define conditions for each metric, Schedule templates execute metrics 
according to the defined schedule.

Collector/analyzer program: Collects the metrics specified in the templates at 
predefined intervals, performs calculations, and forwards data to the OVO data 
collecting agent. OVO checks the threshold values and triggers alarms.

Windows event log: Compares Windows event log entries against predefined 
logfile templates, and forwards error messages to the OVO management 
server.

EXSPI MBox Config: SPI application that configures an Exchange mailbox 
for SPI to access mailbox and folder information (advanced configuration).

EXSPI Add DataSource: configures and starts the logging of data, Enable 
Data Logging/Disable Data Logging: starts/stops data logging.

Graphs and reports: Can be generated using HP PerfView and HP Service 
Reporter.

Persistent store: Saves metric specific values and reports between invocations 
of the Collector/Analyzer.
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Exchange SPI Component Interaction
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Exchange SPI Templates
Installing the Exchange SPI adds the SPI for Exchange template folder to the 
OVO console tree. Double click SPI for Exchange to display the Exchange 
2000 and 2003, and Exchange 5.5 folders beneath. Double click to open either 
folder, and see the EXSPI Quick Start, Add-Ons and Advanced template groups 
for that version of Exchange. Selecting a template group in the console tree will 
display the templates, or template sub-groups within that group, in the details 
pane on the right.

MS EXCHANGE VERSION AND EXSPI PREFIX

This version of the Exchange SPI monitors MS Exchange 2003, 2000 and 5.5. 
Template and Template group names contain the version number in the prefix, 
where 60 refers to Exchange 2000 and 2003, 65 to Exchange 2003 only, and 55 
to Exchange 5.5. For example, where an Exchange 5.5 template group has the 
name EXSPI-55 Event Log Errors, the equivalent Exchange 2000 and 2003 
template group is EXSPI-60 Event Log Errors. 

When templates or template groups are referred to that work for both versions, 
they are referred to in this guide as EXSPI-60/55 <template name>.
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Message Source Templates dialog

For a complete listing of templates with detailed template by template 
specifications, see the HP OpenView Smart Plug-in for Microsoft Exchange 
Server Reference Guide.
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Table of Exchange 2000/2003 templates 

EXSPI-60 QUICK START

Exchange 2000 and 
2003: Quick Start 

Subgroups: 

Templates Descriptions

EXSPI-60 Cluster EXSPI-60 Exchange Cluster Discover 
SysLog

System Event Log for Cluster Events

EXSPI-60 Exchange Cluster Discovery 
AppLog

Application Event Log for Cluster Events

EXSPI-60 Directory Svc 
Access

EXSPI-60 DSAccess Appl Errors MSExchangeDSAccess application event
log errors

EXSPI-60-0023 Exchange DSAccess Cache Hit-Miss 
Ratio

EXSPI-60-15m-DSAccess DSAccess Hit-Miss Ratio
EXSPI-60 Event Log 
Errors

Templates in this group monitor Exchange
error messages written to the Windows 
Event log file and when detected, forward
them to the OVO console

EXSPI-60-Exchange Application Errors Exchange System Errors
EXSPI-60 General Data 
Collection

Templates in this group create data stores
and write data to data stores

EXSPI-60-Log Data (log single instance 
data to OV Performance Agent)

EXSPI-60 Information 
Store

Templates in this group collect data on the
volume of messages processed by both the
Private and Public Information Store 
during the last logging interval

EXSPI-60-0030 IS Public Average Delivery Time
EXSPI-60-0031 IS Public Average Local Delivery Time
EXSPI-60-0032 IS Public Replication Queue Size
EXSPI-60-0033 IS Public Receive Queue Size
EXSPI-60-0034 IS Public Send Queue Size
EXSPI-60-0040 IS Mailbox Average Delivery Time
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EXSPI-60 Information 
Store (cont)

EXSPI-60-0041 IS Mailbox Average Local Delivery Time

EXSPI-60-0042 IS Mailbox Receive Queue Size
EXSPI-60-0043 IS Mailbox Send Queue Size
EXSPI-60-0100 IS User Connection Count Low
EXSPI-60-05m-IS 5m Scheduler for metrics in Information 

Store group
EXSPI-60-15m-IS 15m Scheduler for metrics in Information

Store group
EXSPI-60-DC-IS Msg Delivery Time Collect data on the average msg delivery 

times in core procs
EXSPI-60-DC-IS Mailbox Msg Vol Collect data on the vol. of messages 

processed by Private IS
EXSPI-60-DC-IS Public Msg Vol Collect data on the vol. of messages 

processed by Public IS
EXSPI-60-IS_DbLogRecordStallsPerSec Alarm on Information Store Transaction 

Log Record Buffer Addition Stalls
EXSPI-60-IS_DbLogThreadsWaiting Alarm on Information Store Threads 

Waiting to Write to Transaction Log
EXSPI-60-IS_DbLogWritesPerSec Alarm on the number of times the 

transaction log buffers are written
EXSPI-60-IS_RPCOperations Alarm on number of MAPI client RPC 

operations/sec
EXSPI-60-IS_RPCRequest Alarm on number of MAPI client RPC 

requests
EXSPI-60 Dc-Information Store Log RPC requests and operations/sec

Exchange 2000 and 
2003: Quick Start 

Subgroups: 

Templates Descriptions
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EXSPI-60 Services and 
Processes

Templates in this group monitor Windows
Services for Exchange by checking to see
that Exchange services configured with 
Automatic startup are running. 

EXSPI-60-Connector State Examines the class 
ExchangeConnectorState for condition 
ISUP equal to false

EXSPI-60-Link State Examines the class ExchangeLink for 
thresholds on NumberOfMessages

EXSPI-60-Queue State Examines the class ExchangeQueue for 
thresholds on NumberOfMessages

EXSPI-60-Server State Examines the class ExchangeServerState 
for condition ServerState not equal to 
good.

EXSPI-60-0001 Process Monitor
EXSPI-60-0002 Inactive Process Monitor
EXSPI-60-05m-Serv. & Processes 5m Scheduler for metrics in Services and

Processes group
EXSPI-60-1001 Services Monitor
EXSPI-60-10m-Serv. & Processes 10m Scheduler for metrics in Services 

and Processes group
EXSPI-60-DC-User Connections Collect data on the number of users

EXSPI-60 Internal 
Errors

Templates in this group collect information
on errors occurring within the Exchange 
SPI and contains instruction text for fixing
common problems

EXSPI-60-Messages

Exchange 2000 and 
2003: Quick Start 

Subgroups: 

Templates Descriptions
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. 
EXSPI-60 Message 
Transfer Agent

Templates in this group collect data on the
length of message queues and volume of 
messages (number and kilobytes) 
processed by the Message Transfer Agent
Also collect data on failed, delayed, and 
rejected inbound/outbound associations 
and messages during the last logging 
interval

EXSPI-60-0010 MTA Message Delay
EXSPI-60-0011 MTA Work Queue Length
EXSPI-60-0012 MTA Failed Conversions
EXSPI-60-0013 MTA Connection Message Delay
EXSPI-60-0014 MTA Connection Queue Lengths
EXSPI-60-0015 MTA Failed Outbound Associations
EXSPI-60-0016 MTA Rejected Inbound Associations
EXSPI-60-0017 MTA Rejected Inbound Messages 
EXSPI-60-05m-MTA 5m Scheduler for metrics in MTA group 
EXSPI-60-1h-MTA 1h Scheduler for metrics in MTA group
EXSPI-60-DC-MTA & IS Queue Len. Collect data on the length of message 

queues in core procs

EXSPI-60-DC-MTA Message Volume Collect data on the vol. of messages 
processed by MTA

Exchange 2000 and 
2003: Quick Start 

Subgroups: 

Templates Descriptions
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EXSPI-60 SMTP Templates in this group monitor the 
SMTP queue length, Non-Delivery 
Reports (NDRs), and refused connections

EXSPI-60-0050 SMTP Categorizer Queue Length
EXSPI-60-0051 SMTP Local Queue Length
EXSPI-60-0052 SMTP Local Retry Queue Length
EXSPI-60-0053 SMTP Messages Pending Routing
EXSPI-60-0054 SMTP Remote Queue Length
EXSPI-60-0055 SMTP Remote Retry Queue Length
EXSPI-60-0056 SMTP NDR Percentage
EXSPI-60-0057 SMTP Outbound Connections Refused
EXSPI-60-1h-SMTP 1h Scheduler for metrics in SMTP group
EXSPI-60-5m-SMTP 5m Scheduler for metrics in SMTP group
EXSPI-60-DcSMTP Message Queues Populate Node database with queue 

metrics for graph.
EXSPI-60-DC-SMTP Message Volume Collect data on the volume of SMTP 

messages processed.

Exchange 2000 and 
2003: Quick Start 

Subgroups: 

Templates Descriptions
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EXSPI-60 ADD-ONS

Exchange 2000 and 
2003: Add-Ons 

Subgroup

 Templates Descriptions

EXSPI-60 CC:Mail 
Connector

Templates in this group monitor the 
number of messages awaiting delivery to 
Exchange from Lotus cc:Mail, the rate at 
which Non-Delivery Reports (NDRs) are 
being sent from Lotus cc:Mail to 
Exchange and vice versa

EXSPI-60-0090 cc:Mail MTS-IN Queue Length
EXSPI-60-0091 cc:Mail MTS-OUT Queue Length
EXSPI-60-0092 Exchange NDRs to cc:Mail
EXSPI-60-0093 cc:Mail NDRs to Exchange
EXSPI-60-1h-ccMail Connector 1h Scheduler for metrics in cc:Mail 

Connector group
EXSPI-60-5m-ccMail Connector 5m Scheduler for metrics in cc:Mail 

Connector group
EXSPI-60 Chat Service
(Ex 2000)

Templates in this group monitor numbers 
of clients logged onto chat community, 
and note authentications, failures and 
disconnections related to client timeouts, 
DNS lookup requests and DNS lookup 
failures

EXSPI-60-0830 Microsoft Exchange Chat Service.Active 
DNS logon threads

EXSPI-60-0831 Microsoft Exchange Chat Service.Client 
Timeout Related Disconnects

EXSPI-60-0833 Microsoft Exchange Chat 
Service.Anonymous Clients

EXSPI-60-0834 Microsoft Exchange Chat 
Service.Authenticated Clients

EXSPI-60-0835 Microsoft Exchange Chat 
Service.Authentication Failures

EXSPI-60-0836 Microsoft Exchange Chat Service.Server 
operations queued
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EXSPI-60 Chat Service
(Ex 2000) (cont.)

EXSPI-60-15m-Chat 15m Scheduler for Chat Metrics

EXSPI-60-Dc-Chat Data Collection Collects data about Exchange Chat 
Service clients and channels.

EXSPI-60 Conference 
Svr (Ex 2000)

Exchange SPI monitors and reports on the
Conferencing Management Service, Data 
Conferencing Service, Multipoint Control
Units (MCU) Server, Video Conferencing
Service, and Conferencing Bridge 
Service. These services are offered with 
Exchange 2000.

EXSPI-60-0800 MSExchangeCONF.Active Conferences

EXSPI-60-0801
MSExchangeDcsMgr.DCOM Calls To 
MCUs

EXSPI-60-0802
MSExchangeDcsMgr.Average Load Per 
MCU

EXSPI-60-10m-Conf
10m Scheduler for active conferencing

EXSPI-60-DC-ConfTrends Collect data on trends in conferencing
EXSPI-60 Conferencing 
Bdg (Ex 2000)

Exchange SPI monitors and reports on the
Conferencing Management Service, Data 
Conferencing Service, Multipoint Control
Units (MCU) Server, Video Conferencing
Service, and Conferencing Bridge Service

EXSPI-60-0805 MSExchangeIpconf.Failed User Join 
Attempts

EXSPI-60-0806
MSExchangeIpconf.Video Conferences in
Progress

EXSPI-60-0807
MSExchangeH323.Incomplete Calls

EXSPI-60-10m-ConfBridge
10m Scheduler for failed user join 
attempts and video conferences in 
progress

EXSPI-60 MCU Server
(Ex 2000)

Templates in this group monitor and 
collect data on the MCU service

EXSPI-60-0803 MSExchangeT120.Active Connections

Exchange 2000 and 
2003: Add-Ons 

Subgroup

 Templates Descriptions
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EXSPI-60-0804 MSExchangeT120.T120 MCU Load
EXSPI-60-10m-MCU 10m Scheduler for MCU conferencing 

trends
EXSPI-60-DC-MCU Collect data on MCU conferencing trends

EXSPI-60 Instant Msg
(Ex 2000)

Templates monitor numbers of current 
users online, current subscriptions for 
each virtual service instance, and message
processing time

EXSPI-60-0841 MSExchangeIM Virtual Servers.Current 
Users Online

EXSPI-60-0842 MSExchangeIM Virtual Servers.Current 
Subscriptions

EXSPI-60-0845 MSExchangeIM.Failed Requests/sec
EXSPI-60-0846 MSExchangeIM.Rejected Requests/sec
EXSPI-60-1d-Instant Messaging DC Reporting Collection for Instant 

Messaging
EXSPI-60-Instant Messaging DC Alarming metrics for Instant Messaging

EXSPI-60 IPC 
(Exchange 2000 only)

EXSPI-60-EpoxyClientOutQueueLength Alarm on epoxy client out queue length

EXSPI-60-EpoxyStoreOutQueueLength Alarm on epoxy store out queue length
EXSPI-65 IPC 
(Exchange 2003 only)

EXSPI-65-EpoxyClientOutQueueLength Alarm on epoxy client out queue length

EXSPI-65-EpoxyStoreOutQueueLength Alarm on epoxy store out queue length

Exchange 2000 and 
2003: Add-Ons 

Subgroup

 Templates Descriptions
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EXSPI-60 IS Virtual 
Memory

EXSPI-60-0025 Monitors total number of free virtual 
memory blocks regardless of size

EXSPI-60-IS_VMLargestBlock Monitors the size (in bytes) of the largest 
free block of virtual memory

EXSPI-60-IS_VMTotal16MBFreeBlock
s

Monitors total number of free virtual 
memory blocks that are greater than or 
equal to 16 MB

EXSPI-60-IS_VMTotalLargeFreeBlock Monitors sum in bytes of all the free 
virtual memory blocks that are greater 
than or equal 

EXSPI-60-2h-IS VM Total Free Blocks Total number of free virtual memory 
blocks regardless of size

EXSPI-60 Lotus Notes 
Connector

Templates monitor number of messages 
awaiting delivery to Exchange from Lotus
Notes, the rate at which Non-Delivery 
Reports (NDRs) are sent from Lotus 
Notes to Exchange and vice versa

EXSPI-60-0094 Lotus Notes Inbound Queued Messages 
Length

EXSPI-60-0095 Lotus Notes Outbound Queued Messages
Length

EXSPI-60-0096 Exchange NDRs sent to Lotus Notes
EXSPI-60-0097 Lotus Notes NDRs sent to Microsoft 

Exchange
EXSPI-60-1h-Lotus Notes Connect 1h Scheduler for metrics in Lotus Notes 

Connector group
 EXSPI-60-5m-Lotus Notes Connect 5m Scheduler for metrics in Lotus Notes 

Connector group
EXSPI-60 Mailbox EXSPI-60 Db Mounted Check Events of application event log indicate 

information store mounting/dismounting
EXSPI-60-0070 Mailbox Database File Disk Space
EXSPI-60 Db Mounted Search Search an Exchange server for 

dismounted information store(s)
EXSPI-60-1h-Mailbox Space Usage Monitors mailbox store space usage

Exchange 2000 and 
2003: Add-Ons 

Subgroup

 Templates Descriptions
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EXSPI-60 NNTP Templates in this group monitor the failed
newsfeed connections

 EXSPI-60-0058 Newsfeed Outbound Connections Failed
EXSPI-60-1h-NNTP 1h Scheduler for metrics in NNTP group

EXSPI-60 Public Folder EXSPI-60 Db Mounted Check Events of application event log indicate 
information store mounting/dismounting

EXSPI-60-0072 Public Folder Database File Disk Space
EXSPI-60 Db Mounted Search Search an Exchange server for 

dismounted information store(s)
EXSPI-60-1h-Public Folder Space 
Usage

Monitors public folder store space usage

EXSPI-60 Site 
Replication Service

Templates monitor site replication to 
verify that synchronization updates are 
being processed efficiently. 

EXSPI-60-0110 DS Pending Synchronizations
EXSPI-60-0111 DS Remaining Updates
EXSPI-60-05m-DS 5m Scheduler for metrics in Directory 

Service group
EXSPI-60 Transaction 
Log

Templates monitor the size in MB of the 
Exchange transaction logfiles as well as 
the disk space used by the files. 

EXSPI-60-0004 Percent Low Log File Disk Space
EXSPI-60-0005 Low Log File Disk Space
EXSPI-60-0006 Transaction Log File Disc Space
EXSPI-60 Dc-Transaction Log Space 
Usage

Collects and logs transaction log space 
usage activity

EXSPI-60 Virus Scan
(Exchange 2000 only)

Templates in this group monitor virus 
scans for optimum performance 

EXSPI-60- Virus Scan Queue Length Checks Information Store Anti Virus API
Queue Length.

Exchange 2000 and 
2003: Add-Ons 

Subgroup

 Templates Descriptions
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EXSPI-60 ADVANCED

Exchange 2000 and 
2003: Advanced 

Subgroups

Templates Descriptions

EXSPI-60 End To End 
Message Ping

Templates in this group monitor Email 
service responsiveness by sending an 
Email message from one Exchange server 
to another

EXSPI-60-1002 MSExchange End To End Message Ping 
Monitor

EXSPI-60-End to End Message Ping 30 m Scheduler for metric in End To End 
Message Ping group

EXSPI-60 Event Log 
Warnings and 
Information

Templates in this group collect all 
Exchange-related warning and 
information messages from the Windows 
Event Log

EXSPI-60-Exchange Application 
Information

Application Event Log - Notify All 
Information

EXSPI-60-Exchange Application 
Warnings

Application Event Log - Notify All 
Warnings

EXSPI-60-Exchange System 
Information

Application Event Log - Notify All 
Information

EXSPI-60-Exchange System Warnings Application Event Log - Notify All 
Warnings

EXSPI-60 Reporter 
Collection

Templates in this group enable data 
collections for OVO reports

EXSPI-60-DC-Exchange Info Collect data on Exchange Parameters
EXSPI-60-DC-Mailbox Data Collect data about all mailboxes on the 

system
EXSPI-60-DC-Mailbox IS Sum. Data Collect summary data about Mailbox 

Information Store
EXSPI-60-DC-Public Folder Data Collect data about all public folders on 

the system
EXSPI-60-DC-Public IS Sum. Data Collect summary data about Public Info. 

Store (Folders)
EXSPI-60-DC-TrackLog Data Collect Tracking.Log data
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Table of Exchange 5.5 templates 

EXSPI-55 QUICK START 

Exchange 5.5: Quick 
Start Subgroups

Templates Descriptions

EXSPI-55 Directory 
Service

Templates in this group monitor directory 
replication to verify that synchronization 
updates are being processed efficiently. 

EXSPI-55-0110 MSExchangeDS.Remaining Replication 
Synchronizations

EXSPI-55-0111 MSExchangeDS.Remaining Replication 
Updates

EXSPI-55-05m-DS 5m Scheduler for metrics in Directory 
Service group

EXSPI-55-Event Log 
Errors

Templates in this group monitor Exchange 
error messages written to the Windows 
Event log file and when detected, forwards 
them to the OVO console

EXSPI-55-Exchange Errors
EXSPI-55 General Data 
Collection

Templates in this group create data stores 
and writes data to data stores

EXSPI-55-Dc-SMTP Message Volume Collect data on the volume of SMTP 
messages processed.

EXSPI-55-Measurement Data Collector Forward single instance data to 
Measurement Data Collector

EXSPI-55 Information 
Store

Templates in this group collect data on the 
volume of messages processed by both the 
Private and Public Information Store 
during the last logging interval

EXSPI-55-0030 IS Public Average Delivery Time
EXSPI-55-0031 IS Public Average Local Delivery Time
EXSPI-55-0032 IS Public Replication Queue Size
EXSPI-55-0033 IS Public Receive Queue Size
EXSPI-55-0034 IS Public Send Queue Size
EXSPI-55-0040 IS Mailbox Average Delivery Time
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EXSPI-55 Information 
Store (cont.)

EXSPI-55-0041 IS Mailbox Average Local Delivery Time

EXSPI-55-0042 IS Mailbox Receive Queue Size
EXSPI-55-0043 IS Mailbox Send Queue Size
EXSPI-55-0100 IS User Connection Count Low
EXSPI-55-05m-IS 5m Scheduler for metrics in Information 

Store group
EXSPI-55-15m-IS 15m Scheduler for metrics in Information 

Store group
EXSPI-55-DC-IS Msg Delivery Time Collect data on the average msg delivery 

times in core processes
EXSPI-55-DC-IS Private Msg Vol Collect data on the vol. of messages 

processed by Private IS
EXSPI-55-DC-IS Public Msg Vol Collect data on the vol. of messages 

processed by Public IS
EXSPI-55 Internal 
Errors

Templates in this group collect information 
on errors occurring within the Exchange 
SPI and contains instruction text for fixing 
common problems

EXSPI-55-Messages
EXSPI-55 Message 
Transfer Agent

Templates in this group collect data on the 
length of message queues and volume of 
messages (number and kilobytes) 
processed by the Message Transfer Agent. 
Also collects data on failed, delayed, and 
rejected inbound/outbound associations 
and messages during the last logging 
interval

EXSPI-55-0010 MTA Message Delay
EXSPI-55-0011 MTA Work Queue Length
EXSPI-55-0012 MTA Failed Conversions
EXSPI-55-0013 MTA Connection Message Delay
EXSPI-55-0014 MTA Connection Queue Lengths
EXSPI-55-0015 MTA Failed Outbound Associations
EXSPI-55-0016 MTA Rejected Inbound Associations

Exchange 5.5: Quick 
Start Subgroups

Templates Descriptions
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EXSPI-55 Message 
Transfer Agent (cont.)

EXSPI-55-0017 MTA Rejected Inbound Messages 

EXSPI-55-05m-MTA 5m Scheduler for metrics in MTA group 
EXSPI-55-1h-MTA 1h Scheduler for metrics in MTA group
EXSPI-55-DC-MTA & IS Queue Len. Collect data on the length of message 

queues in core processes

EXSPI-55-DC-MTA Message Volume Collect data on the vol. of messages 
processed by MTA

EXSPI-55 Services and 
Processes

Templates in this group monitor Windows 
Services for Exchange by checking to see 
that Exchange services configured with 
Automatic startup are running.

EXSPI-55-0001 Process Monitor
EXSPI-55-0002 Inactive Process Monitor
EXSPI-55-05m-Serv. & Processes 5m Scheduler for metrics in Services and 

Processes group
EXSPI-55-1001 Process Monitor
EXSPI-55-10m-Serv. & Processes 10m Scheduler for metrics in Services 

and Processes group
EXSPI-55-DC-User Connections Collect data on the number of users

EXSPI-55 Transaction 
Log

Templates in this group monitor the size 
in MB of the Exchange transaction 
logfiles as well as the disk space used by 
the files. 

EXSPI-55-0005
EXSPI-55-0006
EXSPI-55-15m-Transaction Log 15m Scheduler for metrics in Transaction 

Log group
EXSPI-55-1d-Transaction Log 1day Scheduler for metrics in Transaction 

Log group

Exchange 5.5: Quick 
Start Subgroups

Templates Descriptions
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EXSPI-55 ADD-ONS

Exchange 5.5: Add-Ons 
Subgroups

 Templates Descriptions

EXSPI-55 CC:Mail 
Connector

Templates in this group monitor the 
number of messages awaiting delivery to 
Exchange from Lotus cc:Mail, the rate at 
which Non-Delivery Reports (NDRs) are 
being sent from Lotus cc:Mail to 
Exchange and vice versa

EXSPI-55-0090 cc:Mail MTS-IN Queue Length
EXSPI-55-0091 cc:Mail MTS-OUT Queue Length
EXSPI-55-0092 Exchange NDRs to cc:Mail
EXSPI-55-0093 cc:Mail NDRs to Exchange
EXSPI-55-1h-ccMail Connector 1h Scheduler for metrics in cc:Mail 

Connector group
EXSPI-55-5m-ccMail Connector 5m Scheduler for metrics in cc:Mail 

Connector group
EXSPI-55 Internet Mail 
Service

Templates in this group monitor the rate 
SMTP connections to other hosts are 
failing or being rejected for the Internet 
Mail Service, the number of messages 
queued to be converted to Internet Mail 
format as well as the number awaiting 
final delivery, the rate at which 
non-delivery reports are being generated 
for inbound mail and outbound mail

EXSPI-55-0060 MSExchangeIMC.Connections Total 
Failed MSExchangeIMC.Connections 
Total Outbound 

EXSPI-55-0061 MSExchangeIMC.Connections Total 
Rejected MSExchangeIMC.Connections 
Total Inbound

EXSPI-55-0062 MSExchangeIMC.Queued MTS-IN
EXSPI-55-0063 MSExchangeIMC.Queued MTS-OUT
EXSPI-55-0064 MSExchangeIMC.Queued Inbound
EXSPI-55-0065 MSExchangeIMC.Queued Outbound
EXSPI-55-0066 MSExchangeIMC.NDRs Total Inbound 

MSExchangeIMC.Inbound Messages 
Total
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EXSPI-55 Internet Mail 
Service (cont.)

EXSPI-55-0067 MSExchangeIMC.NDRs Total Outbound 
MSExchangeIMC.Outbound Messages 
TotalMSExchangeIMC.Outbound 
Messages Total

EXSPI-55-1h-Internet Mail Services 1h Scheduler for metrics in Internet Mail 
Services group

EXSPI-55-5m-Internet Mail Services 5 min. Scheduler for metrics in Internet 
Mail Services group

EXSPI-55-DC-IMS Message Volume Collect data on the vol. of messages 
processed by the IMS

EXSPI-55-DC-IMS Queue Length Collect data on the vol. of messages 
processed by the IMS

EXSPI-55 Lotus Notes 
Connector

Templates in this group monitor the 
number of messages awaiting delivery, 
and  Non-Delivery Reports (NDRs) being 
sent to Exchange from Lotus Notes and 
vice versa

EXSPI-55-0094 Lotus Notes Inbound Queued Messages 
Length

EXSPI-55-0095 Lotus Notes Outbound Queued Messages 
Length

EXSPI-55-0096 Exchange NDRs sent to Lotus Notes
EXSPI-55-0097 Lotus Notes NDRs sent to Microsoft 

Exchange
EXSPI-55-1h-Lotus Notes Connect 1h Scheduler for metrics in Lotus Notes 

Connector group
EXSPI-55-5m-Lotus Notes Connect 5m Scheduler for metrics in Lotus Notes 

Connector group
EXSPI-55 News Service Templates in this group monitor the rate 

inbound and outbound newsfeed 
messages are being rejected because of 
duplicates or errors

EXSPI-55-0080
EXSPI-55-0081
EXSPI-55-1h-News Service 1h Scheduler for News Service metrics
EXSPI-55-DC-News Message Volume Collect data on the vol. of news messages 

processed by IS

Exchange 5.5: Add-Ons 
Subgroups

 Templates Descriptions
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EXSPI-55 ADVANCED

Exchange 5.5: Advanced 
Subgroups

Templates Descriptions

EXSPI-55 End To End 
Message Ping

Templates in this group monitor Email 
service responsiveness by sending an 
Email message from one Exchange server 
to another

EXSPI-55-1002 MSExchange End To End Message Ping 
Monitor

EXSPI-55-End to End Message Ping 30 m Scheduler for metric in End To End 
Message Ping group

EXSPI-55 Ping Config
EXSPI-55 Event Log 
Warnings and 
Information

Templates in this group collect all 
Exchange-related warning and 
information messages from the Windows 
Event Log

EXSPI-55-Exchange Warnings Application Event Log - Notify All 
Warnings

EXSPI-55-Exchange Information Application Event Log - Notify All 
Information

EXSPI-55 Reporter 
Collection

Templates in this group enable data 
collections for OVO reports

EXSPI-55-DC-Exchange Info Collect data on Exchange Parameters
EXSPI-55-DC-Mailbox Data Collect data about all mailboxes on the 

system
EXSPI-55-DC-Private IS Sum. Data Collect summary data about Mailbox 

Information Store
EXSPI-55-DC-Public Folder Data Collect data about all public folders on 

the system
EXSPI-55-DC-Public IS Sum. Data Collect summary data about Public Info. 

Store (Folders)
EXSPI-55-DC-TrackLog Data Collect Tracking.Log data
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Symbols
$Agent User 2-21

A
actions

automatic in templates 6-115
operator initiated 6-115

alarms, changing the threshold type for 6-111
applications

Disable Data Logging 1-12
Disable EXSPI Tracing 1-12
Enable Data Logging 1-12
Enable EXSPI Tracing 1-12
Enable Message Tracking 1-11
EXSPI Add DataSource 1-10
EXSPI Admin 1-10
EXSPI Graphs 1-11
EXSPI MBOX Config 1-11
EXSPI Node Config 1-11
EXSPI Ping Config 1-11
Mount Exchange DB 1-12
Self-Healing Info 1-11

C
cluster environments, configuring Exchange SPI for 3-65, 

5-98
clustered application configuration file 5-99
command files A-174

UNIX A-175
command line parameters 4-94

changing calculations for metrics 4-95
metric range 4-94
print 4-94
tag feature 4-94, 6-119

component interaction B-181
components

Message Group Bank
EX_Fault 4-87
EX_Perf 4-87
EXSPI 4-87

configuration
advanced 3-65
basic 3-55

mailboxes 3-71
Message Browser 3-58

Create User Account
(Ex2000&2003)/Windows 2000&2003) 2-41
(Ex5.5/NT4) 2-23
(Ex5.5/W2k) 2-31, 2-43

Crystal, report writer used with Service Reporter 7-131
customization

changing the Mailbox Name 6-120
changing the Windows User Account Name 6-120
choosing metrics to monitor 6-121
creating custom groupings 6-110
modifying metric conditions 6-111
modifying metric templates for all databases 6-111
of thresholds 6-116
schedules 6-117
using the tag feature 6-119

D
daily tasks 4-87
data collection

Add-Ons templates 7-135
Advanced templates 7-136
for graphing and reporting 7-131
Quick Start templates 7-131

de-assigning Exchange SPI templates from managed nodes 
3-82

deinstalling 7-152
deinstalling Exchange SPI 3-81
deleting Exchange SPI templates 3-83
disabling tracing 8-161

E
Enable Data Logging

description of B-181
Enabling Message Tracking

Exchange 2000/2003 3-69
Exchange 5.5 3-67

enabling tracing 8-160
End-To-End Message Ping 3-65, 3-73
error log 8-159
errors

common 8-162
Exchange Cluster Config 1-12
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Exchange organization 1-6
EXSPI Admin 1-10
EXSPI Node Config 3-66
exspi_e2k.exe/exspi_e55.exe A-173
exspi_lc.sql A-172
exspierror A-178
exspimwd.bat A-175
exspipv A-172
exspiset.idx A-171
exspispec A-175
exspitra.vbs A-175

F
files

command files A-174
on the management server A-171

G
Grant Exchange access permissions to User Account

for (Ex5.5/NT4) 2-28
for (Ex5.5/W2k) 2-39

graphing, using PerfView 7-151
graphs 1-16, 7-147

Information Store 7-148
Messaging 7-149
System Information 7-150

graphs, in PerfView Graph from a MW DSI logfile 7-151

H
high availability environments 5-98

I
installation 3-55

installing Exchange SPI report templates 7-125
on the management server 3-55
OVO agents on MS Exchange servers 3-56
prior to 3-53
verifying on management server 8-155

instruction text 1-5

L
logfile.dat A-171

M
managed node files A-173

exspierror A-178
logging and trace files A-178
monitor templates A-177
trace A-178
Windows A-177

management server files A-171, A-172
logfile.dat A-171
monitor.dat A-171
msggrps.dat A-171
msgi.dat A-171
schedule.dat A-171
set0.idx A-171
tmplgrp.dat A-171

management server/managed node files
monitor files A-173

management server/managed node monitor files
UNIX A-173

message text, modifying 6-115
message tracking

enable 3-65, 3-67
enabling on Exchange 2000 and 2003 servers 3-69

metric conditions, as contained in monitor templates 1-9
metrics

changing calculations for using command line param-
eter 4-95

showing values for, using -p parameter 4-94
monitor templates A-177
msexchange.apm.xml 5-98, 5-99
msexchange.apm.xml, modifying 5-98
msgi.dat A-171

O
operator initiated actions, in templates 6-115
OVAMTLog.dll A-173, A-174
OVO UNIX 8.0 DCE and HTTPS Agent 1-4
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P
PerfView

graphing data with 7-151
PerfView graph 6-115
PerfView, using 7-151
Persistent store B-181
procedures

service accounts
creating in Windows2000/2003/Ex2000 or 2003 

2-47

R
removing Exchange SPI software 3-81
report templates 7-152
reports 1-16

Exchange 2000/2003 list 7-140
Exchange 5.5 list 7-138, 7-143
requirements 7-126

reports/graphs
time interval required 7-144

S
schedule.dat A-171
Self-Healing Info 8-155
Self-Healing Services 8-155
server connections

setting up 3-73
Service account user with special Exchange privileges 

2-21
service accounts

creating
Windows 2000 & 2003/Ex 2000 & 2003 2-47

severity setting in templates 6-115
swinstall, using to re-install templates 6-121

T
template failures

advanced configuration 8-166
templates

actions as defined in 6-115
advanced configuration template failures 8-166
assigning/distributing 3-67

customizing 4-93, 6-110
customizing message text 6-115
customizing thresholds in 6-114
distributing reporter collection templates 7-145
distributng Quick Start templates 7-144
duration interval, setting/resetting thresholds 6-115
duration settings 6-115
Exchange 2000/2003 list B-185
Exchange 5.5 list B-196
for opccfgupld (OVO upload facility) A-171
installation considerations 3-54
logfile encapsulator templates 1-9
message templates 1-9
monitor templates 1-9
re-installing 6-121
Reporter Collection 7-145
schedule templates 1-9
severity alert setting 6-115
template group prerequisites for Exchange 2000 and 

2003 4-91
template group prerequisites for Exchange 5.5 4-90
template groups 1-9
template groups requirements 4-89
template types 1-9

thresholds
changing 6-116
continuously (with no reset) 6-113
with reset 6-112
without reset 6-112

tmplgrp A-171
tmplgrp.dat A-171
trace files A-178
tracing

turning on 8-160
Troubleshooting 8-153

U
user accounts with special Exchange access permissions, 

how to create 2-22
user privileges 2-21
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